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CX-One CD-ROM contains a setup manual PDF file.
The Setup manual of CX-One is stored in the following file.
Disk1: CX-One_Manuals \ English\ CX-One Setup Manual W444-E1-02.pdf

Before using this product, you must read “Introduction” and “ Safety Cautions”.
Cautions and detailed explanation are available on Help and PDF Manual.
* Acrobat Reader 4.0 or later is required to read the PDF file.
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1. What is CX-One?

CX-One is an FA Integrated Tool Package that integrates Support Software for OMRON's PLC and other
Components.

To construct an FA System based mainly on PLC, traditionally it was necessary to purchase and install
individual Support Software compatible with each Unit, start the software individually, and then connect
to PLC and individual Components.

Installation of this FA Integrated Tool Package "CX-One" on a personal computer allows integrated
operation from setup of OMRON's CPU Bus Units and Special I1/0 Units (SIOU) and Components to
network start-up/monitoring and improving efficiency of PLC System start-up.

2. Features of CX-One

@® CX-One allows integrated management of Support Software for OMRON's PLC/Components.

e Installation on only one personal computer allows a user to handle Support Software for OMRON's
products.

¢ Only one licensing key is required to install all Support Software.

o It allows integrated management of one save location for files created by Support Software.

@ Support Software dedicated to CPU Bus Units and Special I/0O Units can be started on the 1/0 Table.

e The appropriate dedicated Support Software can be automatically started by specifying a
registered Unit in the I/O Table (Unit configuration table attached to a PLC). In addition, setup
information such as PLC model can be passed to the dedicated Support Software at start-up,
allowing easier switching between Support Software.

® The following functions are available by the introduction of the ID information file (CPS) for OMRON
Components.
¢ Setup of CPU Bus Units and Special /0O Units without manual setting and address recognition.
(Parameter and selection item names as well as available range of setup are automatically
displayed)
e CPU Bus Units and Special I/0 Units setting on personal computer and data on actual PLC (CPU
Unit ) can be verified online, and unmatched item/readout data is displayed graphically.
¢ Unit configuration is displayed on the I/O Table based on Unit model.
¢ Device type on the network can be checked for its Unit model, allowing exact verification of
network configuration.

What is CPS?

CPS (Component and network Profile Sheet) is definition information of CS/CJ series Unit/Components in CX-One.
It is provided as a CPS file (XML format file).

CX-One recognizes CS/CJ series Unit by information in this CPS file. CPU Bus Units and Special I/O Units setting
is created based on this CPS file.




3. CX-One Component Checklist

CX-One consists of the following items. Check if they are included in the package.
® CX-One Components

Setup Disk (CD-ROM)

3 disks

CX-One Introduction Guide (this document No.R135)

Printed document and

CX-Programmer Introduction Guide (No.R132)

PDF data on CD-ROM

CX-Designer Introduction Guide (N0.V089)

Function Block Introduction Guide (No0.R133)

CX-One Setup Manual (No.W444)

PDF data on CD-ROM

CX-Programmer Operation Manual (No.W446)

(Only major manuals

CX-Programmer Operation Manual, Function Block (N0.W447)

listed.)

CX-Integrator Operation Manual (No. W445)

CX-Simulator Operation Manual (No. W366)

CX-Designer Users Manual (No.V088)

CX-Motion-NCF Operation Manual (No. W436)

CX-Motion-MCH Operation Manual (No. W448)

CX-Position Operation Manual (No. W433)

CX-Drive Operation Manual (No. W453)

CX-Protocol Operation Manual (No.W344)

CX-Process Tool Operation Manual (No.W372)

CX-Profibus Operation Manual (No.WO5E)

Face Plate Auto-Builder for NS Operation Manual (No.W418)

OMRON FB Library Reference Manual (No. W442)

Smart Active Parts Library Reference Manual (*)

CX-Thermo Operation Manual

Online help only

Software License Agreement/User Registration Card

1

* PDF Manuals are provided for each Unit.

The license number is
printed on the cover,

® CX-One Software List

cx-Che

FA Integrated Tool Package
CX-One Introduction Guide

Software License Agreement

User Registration Card

Model number, license number,
and number of licenses are
printed on the card.

Product Model Installable peripheral tool Included data
CX-One CXONE-ALO1C-E - CX-Programmer Ver.6 - OMRON FB
(for 1 license) - CX-Integrator Ver.1 - Smart Active Parts (SAP)
CXONE-ALO3C- E - CX-Simulator Ver.1 -CPS
(for 3 licenses) - CX-Designer Ver.1 - Manual (PDF)
CXONE-AL10C- E - CX-Motion Ver.2
(for 10 licenses) - CX-Motion-NCF Ver.1
- CX-Motion-MCH Ver.1
- CX-Position Ver.2
- CX-Drive Ver.1
- CX-Protocol Ver.1
- CX-Process Tool Ver.5
- CX-Profibus Ver.1
- Face plate Auto-Builder for NS Ver.2
- CX-Thermo Ver.2
- CX-FLnet Ver.1
- Switch Box Utility Ver.1




4. CX-One Installation Procedure I

Before installing the CX-One, you must:

e terminate all Windows programs

e Uninstall previous versions of Support Software (such as CX-Programmer) if already
installed.

¢ Installation takes about 10 to 40 minutes depending on your personal computer. (10
minutes for a personal computer with CPU: Celeron 2.2GHz, main memory: 512MB, and
CD-ROM drive: 48x)

e To change/modify/delete CX-One after installation, refer to the PDF manual “CX-One
Setup Manual”, Chapter 2 "Installation and Uninstallation”.

Installing CX-One I

Insert CX-One installation disk 1 (CD-ROM) into your personal computer's CD-ROM drive.
[Choose Setup Language] dialog box is displayed. By default the OS language installed on
your personal computer is automatically selected.

Check if the language is appropriate, then click the [OK] button.

Choose Setup Language ﬂ

g Select the language for this installation from the choices below.
o i

Erglizh [nited 5

Click [OK]

CX- Cﬁe

_ Version 1.0

Thi: otected by U.S. and
International copyright d in the About box.

Uninstall older version of tools such as PLC Tools (PLC System setting and 1/0O Table),
CX-Server, and CX-Programmer if they have been installed.

Confirm uninstallation [x] CX-Server is already installed on your computer x|
Cx-Programmer is already installed on your computer, &n older version of Ci-Server Yer 2,2,1,25 has been Found,
To continue the installation of Cx-Server Yer 2,3.0,13, the older version must be uninstalled.
Do you wish to uninstall Cx-Programmer? ‘Would you like Eo uninstall?

Click. [OK] to start the uninstaller. Click [OK] ko continue o [Cancel] ko abort the installation of C¥-One.

IF wou do not want ko uninstall, dick [Cancel].

Always click [OK]

Cancel

Uninstalling CX-Programmer Uninstalling CX-Server



CX-One setup wizard starts.
X

‘Welcome to the InstallShield Wizard for CX-One

The InztallShield® Wizard will install Cx-0ne on pour
computer. To continue, click Next.

Clle[NeXt] .ooo..ooo-ooo.ooo-ooo.ooo-ooo.ooogg&‘ Mext > ’ Cancel

The [License Agreement] dialog box is displayed.
Read the software license agreement carefully. If you agree with all items, select the [I accept
the terms of the license agreement] radio button and click the [Next] button.

C%-0One - InstallShield Wizard

License Agreement

Please read the following license agreement carsfully.

IMPORTANT iI
By installing this package, you agree to be bound by the following Software License
Agreement. |f you do not agree, please return the enclosed software [*Software'] without
installing this package to the shop where pou bought the Software.

The warranty service set forth in Section 7 of the Software License Agreement and any
information on the Software and itz revision and new wersion will nat be provided to pou,

unless pou register as an user of the Software by the enclosed user registration card.
Please promptly fill in the card and send it ta OMROMN Corparation.

S
Select the radio button M e accept the terms of the licenze agreement Print |

& | do ot accept the terms of the license agreement

IrstallShigld

C||Ck[Ne)(t] o-oo-coooo-ooo-ooo-ooo-ooo-ooo-o(ﬂacko Cancel |
~—

The [User information] dialog box is displayed.

User information

Pleaze enter user information.

Please enter your name, company name, and license number, and then click [Mext].

Lzer:
Enter [User], [Company], [oMAON
[License] (product serial Company:
number of CX-One) OMRON

License:

Iristal Shisld

Click [Next] Concel_|




The [Installation Folder Selection] dialog box and [Setup Type] dialog box are displayed.

Select an installation
folder, then click [Next] Setup Type W

Select the setup type ta install ‘M
Please select a setup type. By SeleCting [CUStOm], yOU
can individually select and
install Support Software
from the CD-ROM.

Select the radio button .eee..
[Complete]

Al the applications in Cx-0ne will be installed

£~ Cugtom :
.
@ Select which application you want installed. :
.
reard Bl x
. ) N
llimstall. * o
Instal3hield poine . ‘3""-
C“Ck [NeXt] ceccceccccccccccccococee0 e BN Cancel | want to install, and deselect the features 5§Ju do hot want to install.

.
Drescription

Togrammer -

CxAntegrator Application software to create
Positi and verfy programs of
Posiion SYSMAL C5/C-seiies,

Motion C-series, and CViM1/CY-series
-Mation-MCF CPU Units.

MS-Designer

CH-Process

Face Plate Auto-Builder for NS

C¥-Protocal

ol C-Therma ;I
993,39 MB of space required on the C drive
27115.97 MB of space available on the C drive

IristallShigld

Read the message and ............4("
click [Next] 2 BAe Cancel_|

The [Program Folder Selection], [Choose Destination Location of OMRON FB Library],
[Select Program Folder], and [Ready to Install the Program] dialog boxes are displayed.

i
Ready to Install the Program “ .
The wizard i ready to begin instalstion ‘»“ Insert CX-One Disks 2 and 3

. N then click the [OK] button.
Click Install to begin the installation.

IF you wank bo review or change any of pour installation settings, click Back. Click Cancel ta exit ll

the wizard,
@ Plzase insert the disk: Cx-One Diskz
: E|

@ Please insert the disk: C¥-One Disks
Cancel |
IstallShield

C||Ck[|nSta||] c--o--ooc-oo--ooo-ooo--ooc- Cancel @

CX-One - InstallShield Wizard

CX-One installation is starts.

InstallS hield Wizard Complete

Setup has finished installing C¢-One on pour computer
A dialog box (right) is displayed.
Click the [Finish] button to finish
the installation wizard.

Installation is complete.

(When it is necessary to restart the
personal computer, a restart
confirmation dialog box appears.)

Click [Finish] o

=

¥ Open Readme File

¥ Orline registration




Online Registration I

If the personal computer that the software has been installed on has an Internet connection,
you can proceed to online user registration.

After installation has been completed the [Online Registration] dialog box is displayed.

Online Registration

Do you want ta register online”?

Reqister E=it |

[ D not display thiz dialog again.

If you click the [Register] button, your Web browser connects to “OMRON'’s CX-One Web
site”.(*1) (*2)

*1: If you click the [Exit] button to cancel online registration, the [Online Registration] dialog box
is displayed every time the CX-One Support Software is started.

*2: If you do not have an Internet connection, or you do not want to register online, fill out and
send the user registration card that comes with the product.
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Example of PLC System Construction by CX-One

Workflow in This Chapter |

This chapter describes an example of PLC System construction from design, online debugging on the actual
machine, and start-up/adjustment on-site as shown below.
CX-Programmer is used for ladder program creation and CPU Bus Units and Special I/0O Units (SIOU) setting,
while CX-Designer is used for indicator screen generation. Also, a program simulation Support Software CX-

Simulator is used as a debugging example.

. q q Setting . i
ST N e Ut CPU Bus Checking /0 programming  Offline Debug LI
: ignmen
Programmer  Configuration Units/SIOU Assignment Project
S
O
S
N
S
N —
. S
Design Online Debug of the Machine Start-Up/Adjustment On-Site
’,/”” I' \\ \\
-7 PN \
,,"” l' \\ \\\
. Online . .
Reading Connection  Transferring Program Program 5 Unit .
Project to Machine Debu Modification S
to PLC 9 Change
System Confi gu ration I Unit Name Model Specifications
Power Unit CJ1W-PA202
CX-One CIIW-0C211 CJ1W-AD081-V1 CPU Unit CJ1IM-CPU13 640 points, 20K steps
- Unit No.= 21
nitNo DC Input Unit CJ1W-ID211
CJ1IW-NCF71
(CILW-MCH71) Transistor Output Unit | CJIW-OC211
Connection Cable i — - -
Unit No.= 2Hex 4 analog inputs (Each point
CSIW-CN226(2m) Analog Input Unit CJIW-AD081-V1 | selectable from 1~5V, 0~5V,
@ CJ1W-DRM21 0~10V, -10~10V, 4~20mA)
Unit No.= OHef Position Control Unit CJIW-NCF71 Maximum control: 16 axis
PLC1 Node Address= 01 Motion Control Unit CJ1IW-MCH71 Maximum control: 30 axis
CJ Series PLC|CJ1 - -
T — —— CJIW-SCU41-v1 DeviceNet Master Unit | CJIW-DRM21
o3 & Unit No.= 3Hex - -
q E E E Al o ControllerLink Unit CIIW-CLK21
0 - —
g [0 [ 8o Stra“r;al Communications | ~ 1 \w-scuU41.v1
= TN CIIW-CLK21-V1 .
CJiw-1D211 Unit No.= 1Hex Servo Driver R88D-WNO1L-ML2
4 ~ 20mA Node Address= 01 NS Series PT NS8-TVOOB-V1 8 inches TFT

' J Termination Resistance
Setting= ON

NS Series PT

NS8-TV00B-V1

System Version 6.0 or later

Connection Cable
XW2Z-200T(2m)

Sensor

Servo Driver
R88D-WNO1L-ML2

Below is an example of a System that has CJ1M CPU
Unit with basic input/output Unit as well as analog input
Unit and NCF Unit to perform the following functions:

® 4~20mA input from a sensor

e Configure a servo driver connected to the NFC Unit.



. i . F ; Setting : !
Design Starting CX creating Unit CPU Bus Checking /04 b gramming § Offline Debug saving
Programmer Configuration Units/SIOU Assignment a Project

Starting CX-Programmer I

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Programmer] > [CX-
Programmer] to start CX-Programmer. (Or select [All Programs] > [OMRON] > [CX-One] >

[CX-Programmer] > [CX-Programmer])
zor—— e

B ge= AL lem e
DaulE SR ensEAcs YR [ALeniL i m IR NP E(EEEE Zniny
Rl (o= RN o .

Starting CX-Programmer

. T 3

Creating a New Project Click this button to create a new CX-Programmer project.

File Wiew FPLC
click LI | _ q O ;w =1
e ar o |
I:j Dedicated Support Software for each Unit can be

started, succeeding communications settings from
CX-Programmer. You will not have to set up
communications using dedicated Support Software
if you set up communications here.

"Dewce Mame General |

== CPU Ty
D T ———— | m} |
: - I o
Click and select  ceccoes o[exitisaige e oo oo e o e o { ~[K Settings. Total PlogramArea Size
T 10K [Step] ™ Read Only
e

PLC model. {
IToo\bus J o Settings. Expansion Memap®
. —I [ |N—‘;_| R

r— Comment

Nnni = I~ Fizad Only

TII’EI £ Clock.

: 01_ Iristalled)
B
u]: I .Egncel | Help | Make Default
o

o, ——

Left-click Cancel Help

Settings... | ° .
CIickH and select CPU type.

Click [OK] and
determine CPU type.

=l
[

File Memay™ ‘

Select a PLC model from the following to use Function Blocks.
CS1G-H, CS1H-H, CJ1G-H, CJ1H-H, CJ1M




: : : Setting . 7
. Starting CX- Creating Unit Checking 1/0 : . Saving
DeS|gn Programmer Configuration CPU BUS Assignment Programming ClilE D) a Project
Units/SIOU
Creating Unit Configuration I
Start the 1/0 Table/Unit setup function. U2 e & @e (Q)pE] = [CansLrpamal iem
the menu, you can check the width and current
1=l consumption after PLC Unit configuration.
E%S;WPFD]'E& (Width indication is available only for SYSMAC CJ1)
Double-click [ /0 Table =155 NenPLCU[CIIM] Cffine :
and Unit Setup] :
File Edit ‘iew Options Help :
- CIM-CPU13 e
<3 Inner Board .
[+ [0000] Main Rack .
El% P _ = s, [0000] Rack 01 .
-4 Double-click [ 1/0 T 5 =
Table and Unit Setup]. : =
Rack Power Supply Unit Consumption[ma]  “Width(mm]

Right-click

Select [Add Unit]

Click + symbol on
analog I/O

T Sectionl

- Enp

-~ F Function Blocks

Froject f

CPU Rack I[;J‘IW’-PAZ[IEH =l 530 1257
Rack 01 [Cjpvepezisk x|

CILM-CFOTS T =

Right-click Empty Slot, select [Add Unit] and determine CPU type.
Then select [General Purpose Analog 1/0] from Unit selection window.

T 1 PLC ID Table - NewPLC1
File Edit Wew Options Help

=1 E3

- CIIM-CPU13

4 Inner Board

g [0000] Main Rack

ol - 5 00[0000] Empty Slot
5 01 [0000] Erpty Slot

Uit Camment:
SYSMAC BUS Master e’
.

----- 5 os[oooo]E
----- 5 05 [o000]E

----- 5 o7 [oooo]E P
..... s os[oooo]E  Unit Sefup .o ©

..... o 09[0000]E Save Iia;a‘rfeters
ceccccee dnr gy PODOT] BT © 0P Ea amEters

Start Special Application

Zuk
Copy.
Paste
Delete

Chrl3
Chrl-C
ChrlH

Lnit Manufacturing infarmation
Unit Errar Lag
Hot Swap

Select Unit [ =]

Unit

- Basic /0

£ Commurications Adapter

- Jieneral Purpose &nalog 1/0
o P Motion Contraller

o® | B Pasition Contraller

-- Sensor

- Temperature Controller

Spec

Cancel




. Starting CX- Creating Unit
DeS|gn Programmer Configuration

Select Unit

Setting
CPU Bus
Units/SIOU

Checking 1/0
Assignment

Select Unit Type.

Programming

Urit

B Basic 140
-- Comrunications Adapter
[l General Purpose &nalog 1/0

4]

- CIW-PT S52[Platinum Resistance Thermocouple [nput 1—
[+ Mation Controller
[#- Position Controller

I

o CIWwA0 0414 [Analog Input Unit 4 pointz]

- CI1Ww-DA04T [Analog Output Unit 4 paints)

- CJ1w-DA0BC[ARalog Dutput Unit & points/current)

- CJ1w-DADEY [Analog Dutput Unit 8 pointz/voltage]

- CIWw-MaD 42[analog |A0 Unit Input: 4 points Output; 2
- CI1W-PDC1 5[ solated-tupe Analog [nput Unit)

- CI1W-PT 515 solated-type Thermocouple Input Unit)

- CJ1w-PT 516 zolated-twpe Resistance Themometer [npr
- CI1Ww-PTS51[Thermocouple Input unit]

| o

Spec

Click ol4 |

o N
Co D o |

Select Unit and Number.

Urit name:  Analog Input Unit 8 points

Unit type:  CITW-AD 0BT

(

Uit 21 -l

Click 0] | ............................... Cancel

input range 0 - 95

Comment:

Enter Unit number.

=

Offline Debug

Saving
a Project




Starting CX- Creating Unit

Setting

De Si n ) : CPU Bus
g Programmer Configuration Units/SIOU

Checking 1/0
Assignment

Saving
a Project

Programming  Offline Debug

The Analog Unit is registered to the I/O Table as shown below.
Set up the next analog Unit's parameter.

T 1 PLC ID Table - NewPLC1
File Edit Yiew Options Help

I[=] B3

-~ CIIM-CPU13
+|-dggy Inner Board

--&§ [0000] Main Rack
Double-click the analog _3’1 00 [0000] Empty Slok

L WA=y

Unit r

/1(Analog Input Uni

1; L ap=u o
..... 5§ 04 [0000] Empty Slot
..... 5 oS [0000] Empty Slot
..... 5§ 0 [0000] Empty Slot
..... § 07 [0000] Empty Slot
..... 5 03 [0000] Empty Slot
..... 5 09 [0000] Empty Slot
[+, [0000] Rack D1

[Cam-cru1a  [Offline 4
The Analog Unit Setup Screen is displayed.
CJ1W-AD0S1-¥1 [Edit Parameters]
Displayed Parameter |2 ) ) ) )
CPU Bus Units and Special I/O Units Setting
Itern SetValue Lnit - .
Input! Input signal use sefting Disahle FUI’]CtIOI’]
T oI Fromm—v i Traditionally, initial CPU Bus Unit and Special
Inputd Input signal use sefting Digahle . . .
InpUIS It signal use seting Cisabe 1/0 Unit settings were made by referring to
Inputfi Input signal use sefting Digahle .
Inpu? Inpus signal use sefing Disable documentation to calculate DM address from
Input Input signal use sefting Disahle . . .
InpUt Input range sefting e, the Unit number and entering a hexadecimal
Input2 Input range setting +-10Y . -
Input Inpi range sefing P number. Now you can set it using the pull-down
Inputd Input range setting +-10Y . g
InpUtS Inpu rane sefing 1oy menu in the CX-Programmer’s 1/O Table.
Inputfi Input range setting +-10Y LI . . .
=i C Easy setup/transfer/verification operations are
= =l available from the integrated parameter settings
screen as shown below, without recognizing
o c addresses (this function uses CPS function of
Tiznstent o pe] || Tianstetreiong | | Compare | Resst CX-One previously described).
Set Defaults Cancel

Setting CPU Bus Units and Special 1/0 Units I

For example, specify input number designation and range.

C11w-AD081-¥1 [Edit Parameters]
Unit parameter setting il Pasnets [T 5
Itern nit =
Inputt Input gignal use sefting Enahle | Select [Enable] for input No.1 usage designation. |
INpUtZ Input signal use setting |
Input3 Input signal use setting Disable
Inputd Input signal use setting Disable -
Inputs Input signal use setting Disahle
Inputé Input signal use setting Disahle
Input? Input signal use setting Disable
Inputd Input signal use setting = e [
i) T G L ouzomn )!: Select [1~5V/4~20mA] for input No.1 range setting.
Input2 Input range setting 2
Input3 Input range setting +l- 10V
Inputd Input range setting +- 10
Inputs Input range setting +H0Y
Inputs Input range setting -0 LI
- Help
+| | <DefauibDisable =
<Address>Word:D22100, Bit1
<TypesList
TrersterlUric o PE)| | | TianstetPC o ni] || Gompere | Reset |

Set Defaulls

— Click the [OK] button.




Design

Right-click NCF Unit

-

Point [Start Special
Application]

]

Click [Start with
Settings Inherited]

Double-click NCF Unit

—
—

Click *n|

4

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Checking 1/0
Assignment

Programming

Offline Debug

Saving a
Project

NCF Unit and Servo Driver Connected to the NCF Unit Setup I

As with Analog Unit registration, register the NCF Unit (CJ1W-NCF71).

The NCF Unit resides within a position control

Unit.

Nest, start CX-Motion-NCF using [Start with Settings Inherited].

When opening a stored project file after starting the dedicated tool, select [Start Only].

If [Start with Setting Inherited] is selected, a new project is created.

7§ PLC IO Table - NewPLC1
Fle Edt Yew Options Help

[_ O[]

& Untitled - Cx-Motion-NCF
File Yisw PLC Unit Help

- CIIM-CPUL3
4, Inner Board
E-&§ [0000] Main Rack

{© 5] 00 [0000] Empty Slot

5 01 [0000] Empty Slot:

5 02 [2210] CI1W-ADOB1-¥1{Analog Input Uit 8 poinks) (Occupancy ¢ 13(Unit : 213 (Out: 1, In: 93
5 ontrol Unit) (Unit : 2)

L. m—
§ 0S[0000]E1  Change { Confirm Units
3§ 06 [0000] £

§ o7 [0000] £
51 080000l &1
. g o9oooo] e
4, [0000] Rack €

Unit Comment:
SYSMAC BUS Master 3

Unit Setup
Save Parameters
Load Parameters

s Inherited

D= Y« R
Capy Chrl+C
Easte Gl
Delete

Ut MenuFackuring infarmation
Uit Etror Log

DMl ad( 08
£ Unit Mo.0Z (Position Contral Unit) (CI1w-NCF71) [No comment]
T —

.
Press [F1] to disglay help.

I

Hat Swep 1M-CPULS  [Offfine 4
Register a servo driver.
| Untitled - CX-Moktion-NCF =]

Elle Wiew PLC Unit Help
DeHsEHE

# PLCLCT Serie:

Double-click NCF Unit.

Displayed with NCF Unit registered.

8 CI1%-NCFT1 Axis Map

Edit Online Help

i

Press [F1] to display help. ’7’7’7’7
Mew Driver
r— Drriver name
INew Drriver 01
s Select OMRON W series (with
IDMHDN ' S eries with Communication IF '| communications function)
r Drriver model
lHBBD-WND1L-ML2 v|< e
L — Select R88D-WNO1L-ML2.
iz Mo
IAHis m 'l
— Commert
_'I_I
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Double-click NCF Unit il
=

Starting CX- Creating Unit Cspedﬁggs Checking 1/0
Programmer Configuration Units/SIOU Assignment

Saving
a Project

Programming , Offline Debug

Edit NCF Unit parameters.

Fie Edit ©nline Help = Unt Paramaters —Memary Area Setting
>< . .'.M Mamory Area Satt | [ Axis Operating Memory Arsa Designation———————————
Bolm| x| g t-|1-]e5] e
Unit ] = iz Setting = {
DILMLZ) i 01
K Input Memary Area (NC Unit to PLC)
. ~| [s00 =1
B =] | =
D
D
. CID area: CI00000 to CIOBT43 /A arel: OO0 to W51 1
HR area: HOOO to H511 AR area; 8000 to 4953
. . DM area: DODDDD to D32767
Double-click NCF Unit. | EM area: E7_ 000D to E7_32757 [7=EM Bk Ma.]
Each area accupies [the largest axis No.* 2% words.
L]
4] I Bl >
Dowrload Uploed ! °
Set output relay area to

Iritslizes ClO100 and input relay
area to CIO500.

Jeceecccee Select [Axis 01].

d Parame Ed
N
SeleCt = Unit Parameters: i Congy ) ) Unit Paramigters [~ Asis Setting Axis 01
. . . At Communications Settin i Memopéuea St | Encoder Type:
LN N N ) Ll H
[Communlcatlons Settlng] Y o Commibicationgk | ppsoits Encoder ) Inoremental Encoder
Transfer Cygfms) [1ms =l
. o Oiigin Saarch Opsi
Click Communisations Cycle (Multipler][3 = TEMECELEN SRR
K & Reversal Mode 1 RewersalMode 2 € Single-drection
. . osof Cammunicalions Retries [1 =
Auto Communications Setting] eeceefeccccccccp Oigin Seaich Ditction
[C2 Master Connection C2 Master not connes ™ 1 Forward  Reverse
B e 1 b T ] Intermupt Input Signal Selection [10, 1 E stemal Latch 5=
No. of Commurications Reties 0 to 7 [ime]
Transfer Gyele [ms] # Communications Gyl [Muliplier] Orgn rput SgnelSekoton  [prasez =]
¢=32[ms]
4 i
e | —
Doribed Upload Compare
MPErE:
T = Set axis parameters
— — for axis 01
or axis o
—
B
.

driver

El-ﬁ Urit Mio.02 Mew MCT[CITWw-MNCFT1) A Input signal selection 1 1H

DOUb|e-C|iCk the SeIVO essescccboee .ﬁ 01 Mew Driver 07(R -MLZ] =[] Pn&0B  Input signal selection 2 a8a2H
——m =[] PnS0E  Output signal selection 1 noooH

=[] Pna0F  Output signal selection 2 0100H

=[] Pna10  Output signal selection 3 noooH

=[] Pna11  Input signal selection 6543H

=[] Pn512  Output signal reverse ooooH

Save the project

Edit servo parameters.

File Edit Online Help

A Bal@| x| e[t e-]es]

&

[1PnS1E  Deviation counter overflow warnin... 100

[ Pns20  Deviation counter overflow [evel 262144

[J Pn522  Positioning complefion range 1 3

[J Pn524  Positioning completion range 2 3

‘i Ilj Ph526  Deviation counteroverlﬂow\evel at.. 262144 o
N

K 2
.. Download I Uplaad | LCompare |
.
. p——
: Initialize | " Cancel

Set servo parameters for axis 01 as shown below.
Pn50A(input signal selection 1): 2881 )
Pn50B(input signal selection 2): 8883 Click
Pn511(input signal selection 5): 6541

Refer to Page 2-13 “Saving Project” for details.
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Right-click MCH Unit

]

Point [Start Special
Application]

{

Select [Start with
Setting Inherited]

—

Add task, axis, program,
and CAM data

—J

Edit position data,
parameters, program,
and CAM data

—

Save the project

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Checking 1/0
Assignment

Saving
a Project

Programming , Offline Debug

Using the MCH Unit

When using the MCH Unit (CJ1W-MCH71) instead of the NCF Unit, use the following settings.

As with Analog Unit, register the MC Unit to the 1/O table.
The MCH resides within the Motion Controller.
Then start CX-Motion-MCH using [Start with Settings Inherited].

When opening a stored project file after starting the dedicated tool, select [Start Only].
If [Start with Setting Inherited] is selected, a new project is created.

i PLCIO Table - NewPLC1 g [= 5]

Fle Edt View Options Help

 om-cpuls

@, Inner Board

£-%{ [0000] Main Rack
- § 00 [0000] Empty Slat
- ¢ 01 [0000] Erpty Slot
o §f 02 [2210] CILW-ADDBL-Y1(Analog Input Unit 8 points) (Occupancy : 1(Unit : 21) (Out: 1, In; 9
5l I ontrol Unit) (Ui : 3)
-1
i ] 05 [0000] Empty Slok

Change | Confirm Units
¢ 06[0000] Empty Slat Uit Comment
i 1) 07 [0000] Empty Slat SYSMAC BUS Master 3
- g) 08 [0000] Empty Skt
¢ 09 [0000] Empty Slot Unit Setup

-4, [0000] Rack 01 Save Parameters

Load Parameters

—_—_— Crlx

Copy Ctrl+C
Paste Chrl . .
etz Start the MCH Unit as registered.
Al Uit Manufacturing infarmation
Uit Errar Log) line:
Hob Svap)
GIE]
B Gt Yow ot Grie Tock Wrdows” b
DEE|«P RE|[ e nidtR|oEEBIg
EAEHRAREAMGERX A o8 |
HewPLTT -
o [F] [E) | Click to add task, axis,
et program, and CAM data.
4
-]
AT LTI, Cormpsie § Tonrutten
[ [t 2
Pragect - L Mution-MCH - [TargetSI00 (3] : NewProgram (111 =101 x|

_mmmmmmmw =iei x|

[DEd HR& @R o ANE (P | OERRS [ DB B |

[rbgmaprroeexEs [eamn
s

FRoC FODL 00000000 =l

RS Nonfil KOVE [J01110900 (302150000
=@ Twpesion

B Skl -1

M Fusiion Dot

-0
1150000 (J02]75000

1YL Puameter 9
g Sotings VELL TI00
L Sntings HOVE (J01]100000 [J02]100000
=5 B Tahs i
(@ HewTas 1) HUOBAL = 1
Jnes KOVE [J01]30RIGIN [J02]50RIGEH
i

FOUDTAL = O
0

HewPaogpant 1)
g ——
B NewSutogenton [500)
[

Open the editing screen to edit data by double-clicking
position data, parameter, program, or CAM data on the
project tree.

L]
Illllllllll...
B Hewtanat 1)

=
gl

I 1 I3 ] NS ey
= [z oz jolie

Click E Iand save the project to file.
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Checking 1/0 Assignment I

As with Analog Unit registration, register the IN and OUT Units.

7 PLC ID Table - NewPLC1 [H[=] B3

i In this example, CJ1W-1D211

T o

zad " and CJ1W-OD211 are selected
-1/ 00[0000] CIIWHID21 1(DC Inpuk L) as IN and OUT Units respectively.

01 [0001] CI1W-0D21 1{Transistor Output Unit)

02 [2210] CI1W-AD0E1-¥1{Analog Input Unit 8 paints) (Occupancy @ 13(Unit : 21) (Out: 1, Ini 9

g 03 [1550] CI1W-MCF7 1(Pasition Control Uit (Unit : 2)

sl 04 [0002] Empty Slot

5l 05 [0002] Empty Slot

06 [0002] Empty Slot

07 [0002] Empty Slot

08 [0002] Empty Slot

5l 09 [0002] Empty Slot

a, [0002] Rack 01

Register basic I/O Unit

[Cam-cPuz  [Offine 4

By registering Units to the I/O Table, you can check 1/0O assignment status.

7 Clm-cruls
iy, Inner Board

Check 1/O assignment T0000] Hiein Rack

021 1(DC Input Unit)

01 [0001] C1wWHDD211{Transistor Qubput Unit)

02 [2210] CIwRD0S1-Y1{Analog Input Unit 8 points) (Occupancy @ 1(Unit : 210 (Out: 1, In: 93
03 [1550] CIW-MCF7 LiPosition Conkrol Unit) (Unit : 2)

04 [0002] EmptygSlat

05 [0002] Emply Slot

----- 5 08 [0002] Empty Slat

----- 5 07 [0002] Empty Slat
_____ ﬂ 08 [0002] Empty Slot FLC 10 Table - WewFLC1
Ama L Inpat Unit § points (CI1IN-ADORL-VI) (21)
----- 5 09 [0002] Empty Slat ?§§§1 o) Sl Input siansl vse settina
1 ] mpat? Input signel use setti
[+, [0002] Rack 01 p22100 2 pat] Inpat siqual use setting
D22100. 3 mpatd Input signel use setting
D22100.4 nputS Input signsl use setting
D22100.5 mputé Input signal use setting
D22100 .6 nput? Input signsl use setting
D22100.7 mputd® Input signal use setting cDisable(0Bax) >
D22101.0 { {11 ¢1=5V-4=20nh{ ZHox) >
'S D22101.2 /=107 { 0Hex ) »
In addition, you can check addresses pezioi 4 - ; ox
. . . D22101.8) 5
assigned to actual I/O with a print out bazton 101
. D22101.12)
022101, 14]
D22102) value processing for I buffers((e
D21 2} lue processing setting value processing for I buffersi(Re
D22104 lue processing setting <Mesn value processing for I buftfers(OBe
D2210%) lue processing settisg <Hean valus processing for 2 buffers(0Be
D22106) lue processing setting <Mean value processing for I buffers(0Be
D22107) .51 lue processing settisg <Hean valus processing for 2 buffers(0Be
D22108) aput? Mean value processing settisg iHean valus processing for 2 buffers(0Be
022109 Inputd Mean value processing settisg iHean valus processing for 2 bufters(0Be
D22118.0) Operation mode setiing tHormal mode(lHex) >
022118 %] Conversion time-resolutios settisg < 1na 4000 OBex) >
CIo2210.0) apuat] Peak valus hold cHot used{0Hex)>
€I02220.1] npatZ Peak value hold  cHot used|iHex)>
CIo2210.2) aput} Peak valus hold st B
CIoz210 3] nputd Pesk value hold Hot 'H
€I02210 4] mpat Peak value hold  cHot i
Er.l 2210 5] npuath Pesk value hold Hot 1)
€102210 6] npat? Peak value hold  <Hot 3
(102210 7] mputd Peak value hold  <Hot B

This 1/0 assignment information can also be checked by IQ indication (IN:l, OUT:Q) during
ladder programming.

1}
0 [Program Mame : MeweProgramd]
[Zection Mame ; Sectiont]
I 0.00 G 1.00
1
[
1 E :
” -
p -
e ;
p -
e ;
” “
b -
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Programming I

This section describes programming with Library (OMRON Standard Libraries) that allows
easier connection to OMRON'’s Components. OMRON Standard Libraries is a group of
Components provided by OMRON, which can be categorized into two types; FB Components
(OMRON FB Library) to be used for a ladder program and SAP Components (Smart Active

Parts Library) to be used for an indicator.

@® NCF Unit Programming with OMRON FB Library
Servo motor (axis 1) connected to Unit number 0 NCF is moved to position 2000
(command Unit) with speed of 2000 (command Unit/s) by relative move command.

Right-click from Function
Blocks

]

Select a folder from
[Omronlib] > [Position
Controller] > [NCF]

—J

Select OMRON FB Library
" NCF021_MoveRelative
DINT11.cxf"

]

Enter “MoveRelative” for
instance name. Then
create a ladder program

(-5 NewProject
= T8 NewPLCI[CI1M] Offline
5 symbols
@} 10 Table and Urit Setup
.5 settings
g Memory
=% Programs
155 NewPragram1 (00)
22 Symbals
-5 Sectionl
-6 END

& o
B2 Copry
I paste

Defete

[ dllow Dacking
Hide

Float In Main Window

Properties

Iy Project /

&0 Unit No.: 0
cPU NCF 4
Servo Motor No.1
(Axis 1)
] =
w1000 W10.01 W10.03 W10.04 W10.05 W10.02
1 I | | |
I T U 1 T L T 1 T
Start Trigger (ENO) Done Command Error
StartNo.2
W10.02 Aborted
|
f f
Start No.2
P_On (Normally ON) _NCF021_MoveRelative_DINT ENO
EN (BOOL)
(BOOL) ENO
Unit No. __| UnitNo (BOOL) |_ Positioning is completed
&0 | (INT) Done | W10.03
Axis No. __| Axis (BOOL) | _ Command is aborted
Axis 1 — &1 | (INT) Command Aborted | W10.04
Start No.2 __| Execute (BOOL) | _ Error Flag
W10.02 ~ | (BOOL) Eror [ W10.05
Position Command __| Position (WORD) |
2000 Command Unit > &2000 | (DINT) ErrorlD (Omitted)
Velocity Command _| Velocity
2000 Command Unit/s —» &2000 | (DINT)
==

Select CX-Programmer Function Block Library File

Laok jn: [ 53 NCF

] _MCFO01_Connectionl0, cxf

@ _MCFO10_MoveAbsalute_REALTL.cxf
Q _MCFO11_MoveAbsolute_DINT11.cxf
Q _MCFO12 _Moveabsalutez_REALLO, cxf
@ _MCFO13_Moveabsalute?_DINT10.cxf
Q _MCFOZ0_MoveRelative _REAL1T, cxf

|

_MCFO23_MoveRelativeZ_DINTL0, cxf
_MCFD30_MoveVelocity _REALLL,cxf
_MCFD31_MaoveVelocity_DINT11.cxf
_MCFO40_TorqueControl_REALLL.cxf

|

File name:

|_N CF021_MoveRelative_DINT11.cxf

Open I

Files of bype: IFunction Block Library Files(.cxf]

d Cancel

v

=

Paste the selected OMRON FB Library on the ladder, then enter its name (instance name)

(in this example, “MoveRelative”). Then create a ladder program as shown below.

== o | [ FPresram Name : NewProgram] -
=58 NewPraject =
£ T2 NewPLC1[CIM] Offine: [Section Name : Sectiont]
23 Symbols
7] 10 Table and Unic Setup Wi0.00 WD w1003 WID.04 w1005 W00z
(8] settings — | | 1 % 11
@ Memory StatTrigger ENO Done Pause ErrorFlag
-G Programs W02
-5k NewProgram1 (00} E—
51 symbols Start2
g Sectiont 1 l MaveRellive I
& o 7
= 2 R L a
— EN ] o S
Aoy ON Flag
a0 (INTY (BO0L) Wi10.03
Linitlcs Donél  pone
&1 (NTY (BO0L) W00
Axis Command_&h | pause
ortedt
w002 (BOOL) (B00L) Wi10.05
Startz Execute EfforL ErrorFlag
22000 |(DWT) (ORD)
Distance ErtoriD|
22000 |DNT)
elochy

OMRON FB Library is a collection of Components that OMRON provides as a Function
Block to use functions of OMRON's Units for PLC and FA Components much easier on a
PLC program. * For details, see FB Introduction Guide, Chapter 1.
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See Library
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Select [Library] from the
[Tools] menu

Place Smart Active
Parts on the screen.

1. Select SmartActiveParts E

-Motion - NCF -
OutCIO_InCIO folder .,

Creating Unit
Configuration

Setting
CPU Bus
Units/SIOU

Checking 1/0
Assignment

Programming

Offline Debug Saving

a Project

How to use Smart Active Parts

This section describes how to use Smart Active Parts. In this example, NCF Smart Active Parts
“Adjust Operation” is used.

From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer

Ver.1.0] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer]
> [CX-Designer Ver.1.0].) Select [NS8-TVO0[]-V1] and [System Version 6.0] or later

B Test. Cir+ B

. wl Besource Report.  Girl+R
° Data Check 4
Library Alted ||

Import Old Librarw..

&

S} ISmartAcl\veParts_jl 1 UUZj IAII
B[] SmarticliveParts_E

-1 TemperatursContraller
@] GervaDriver

Library

| &4 Find % Pz g4 Next

Profibus fxis busy  Override setting Speed CMD wvalue g1y
amE O [ Disdble || 9000 % | w06 || 0090900 |V [pulsese V|
B[] Mation
:g \r:;'?'h”‘e' ﬂxwelﬁ Decel.stopl Servo unlock | -JOG | Orig.search| Orig. return
[ DUDM_InDM P -
] OuDM_InCI0 “FO0T _20_Adjust Operation
[T OutCI0_nDM -
~[] DuEID_nC10 U eeee®

2. Select _NCF001_xx
_Adjust Operation
(Check the Title)

Setup Smart Active
Parts

<

4. The selected Smart Active Parts are
displayed on the screen.

1. Double-click

2. Set 4 to the Destination °°

Unit No.
3. Click [OK]

Smart Active Parts
Setting is complete

Setup is completed at 100%

Save the Project. I

Axis busy  Override setting

Speed CMD value o1y

() Diseble |[909.99 % | w08 || -0990000000 |V [puleess V|
q W

xwem Decel.stop| Servo urﬂock| -J0G | 0rig.search| Orig return|

Axis busy  Override setting

o

3xis| 99 | Decel. stopl Servo urﬂockl -J0G | Orig. search| Orig. return ....

Dissble || 909.95 % | +J0G || -9999990009 [V [pulsess V|

Speed CHD value po.n

Refer to Page 2-13 “Saving Project” for details

3. Drag & drop it on the screen.

SAP Communications Setting

Disstination Address |

Command Destination Port Name

[ estination {etwork Address
Westiation Hode Addiess

DestinationUnitN o
ceee®® °*

|_ DeviceMet Slave Address

| |

| ER |

4. Communication address is
automatically calculated according

to the corresponding Unit.

Cancel

Setting Smart Active Parts Communication address.
Pleagze wait...
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a Project
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Programming , Offline Debug

Offline Debug |

This section describes how to debug a program using CX-Simulator, a ladder simulation tool,

without the PLC.
Additionally, Switch Box Utility is used as a virtual input tool.

9 Jntitled - CX-Programmer - [NewPLC1.NewProgram1.Section1 [Diagram]]
0 DF“E Edit Wiew Insert PLC Program Tools Window Help == x|
Click %l Rf@'\‘éﬂ?&ﬁ‘%ﬁfﬁ'@'\‘ﬁ“%\"?\"[H&J,@’%ﬂ,‘;II|ﬁ[ﬁ\&#@\gm%@| w | o .
aoqliskEsErRruirnw ) —oPETRE |2 os| vy B EELED|
DBE (w8

(Simulator connection button) mEREDS |6 =

~—

Program transfer starts.

Download Options

C"Ck[OK] ®ecccscccccccccccccce s ile HaFlERoccscccss Download
Inchud Program Download to PLC NewPLCT

rograms)
Seftings
- 187 10 table

DQ Special Unit Setup Transfer Al

2 S Symbols

Comments

(3 Program index
Download suecessful

CHEKIOKT  vevvanerreeeennneees bgmepnsgoanngeceesnnnneeeens

Transfer To/From:  |Memary card hd

1 Transfer files of all tasks

" Transfer files by the task

¥ | Clear progran memony

I™ Exclude Port{HostLink, Peripheral) of PLC Settings from the:
transfer target.
[Check when transferting CPU unit serial comms part settings
changed by MT Link auta-anline ar CPU unit parameter edit of
CxAntegrator.)

Screen when online
: Tools Window Help
L

=% Untitled - CX-Programmer - [[Runnip~*

. Fle Edit Wiew Insert PLC Progrdh Tools .
ees
CX-Simulator debug FETRIEIE ) e \M % 2 |[|alI]E 20 e PRy i R Ef)
console is starts aoQFsmER|Rarwirwl —osa Bk ||B Smas ey
"0 CERBOS 6= E|28B8e s
. .
5 Kevboard Mapping. ..
.°, =l fo o | [ Frogram Hame : NewProgram) . I
[ L E% MewPraject thions. -
. =] % MewPLC1[CI1M] Monitor Mode [Section Name : Section]
q A AR . 8
Starting Switch Box Utility
W10.00 Wino WAD.0% W10.04 Wi0.05 W10.02
Select [Tools] > — | || 14 1 4
X . o StartTricger ENO Done Pause ErrorFlag
[SWltChBOX Utl"ty] o* 2= w1002
o' &) PLC Clack —
.
o® et Mernory Start2
o® =+ Programs i MoveRelative
o° S ﬁ MewPragram1 (00) Running 7
] ; _WCFO21_MoveRelative_DINT
Run PLC ! o) (8oL winm
En ERO |
=-IF R [l
W Fiee) vewty) PLCE) Addressia) Helpit
J IUntllIed Group j
Bit Manitor -
G EzmET! Address Valug Caomment
W10.01
Wi 0,02
wi10.02
w10.04
W10.05
| | _'l_I
F1Pragram F2Monigor FaRun ADebug) |F5Auto Qnline IFGSeIed Port
F7Bit Monitor |FB.D‘1 Manitor ‘FBWa(vh Munl(urlHUCummenl |F116rp.tummen|F12New\uum Set |
- [@ [cm-cpurz [PR&  |HER _’lJ
', Project / ~2 | Name: | Address or Yalug: | Comment: |
For Help, press F1 2 [ [MewPLCL{Simulator) - Monitor Mods | soms [SYHNC [rumg 2 (0, 0) - 100% 7

Switch Box Utility
It is useful not only for virtual input by simulator but also for debugging

while checking the PLC’s wiring or setting the DM and other initial values.
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Saving a CX-Programmer file

_IBL File Edit Yiew Insert PLC Program Tools ‘Window Help REE
|t Dosew.. i (@0 ns%2e|erBaltn iR (ELRETEE | wa.
= [ Open... Chrl+o
< Cioe [RArsurw | —opEEL |3 9@ 0w ns B BEED |
J|—|] & save Ctrhs [ ‘ 1o %&’E| 4 A5 ‘
From the [Flle] menu, e © ¢ E zlxl fo 0 [Program Mame : MewProgram1] a
»
select [Save AS.. ] Reusable Fie [Section Name - Section]
Function Black »
W10.00 w1001 W0 03 004 w1005 W00z
Load Comment Program | i 11 11 11
Save Comment/Program StartTrigger EMO Done Pause ErrorFlag
w1002
BB Compate Program...
Start2
Page Setup... & _
E\ Rt Pz 1 ; MoveRelative
& Print... Chri+P _NCFO21 _MoveRelstive_DINT
i, S o P_On (BOOL) (BOOL) W -
= . 1+ v
ﬁ Exit =4 Name: Address or Yalue: | Camment: |

Saving CX-Designer and
CX-Motion-NCF/MCH files

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Saving a Project I

Checking 1/0
Assignment

Saving
a Project

Programming  Offline Debug

Unit setting, Unit parameter setting, and programs using the CX-Programmer can be saved all

at once.

9 |jntitled - CX-Programmer - [NewPLC1 NewPragram1.Section1 [Diagram]]

Saves the project with @ new name

[MewPLCL(Met:0,Mode: 0 - Offfine [ [

[rung 2 {0, 0) - 100%

Y.

&

Save it with a name. In this example save as “Samplel”.

Save CX-Programmer File

Save in Ia Dema

= & E ek E-

File name: ' |Samp\e‘l ' [

Save as lype: IE}(-F’rUgrammel Project Files [*.cxp)

e

eeessss Click

Save

j Cancel
£

Created data can be saved for CX-Designer and CX-Motion-NCF/MCH.
Save CX-Motion-NCF as “Sample2.mnf’ (CX-Motion-MCH as “Sample5.mnh”), and CX-

Designer as “Sample3.ipp”.

Saving screen for CX-Motion-NCF

Save

Save jn: | ‘2 Demo M K3 il

File name:

.
. Save
e ]
j ®  Cancel
y A4
.

ISamp\EZ

Save a3 bype: | C¢Motion-HCF Filef* mn)

.
.' Save as twpe: IPrn\e:t file[*IPF]
.

Saving screen for CX-Designer

Save Project As

[7]x]

Savejn | £3 Demo M K ef BE-

.
f!!e hame: |5ample3

Save I
j Cancel

4

If you run a dedicated Support Software such as CX-Motion-NCF or CX-Designer when CX-
Programmer is started, the same default folder location as that of CX-Programmer is used for
reading and saving files. It allows easier CX-One Support Software file management.
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Project
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This section describes connection to the machine, transfer of programs, creating Unit settings

offline, and how to debug.

Reading a Project I

From [File] > [Open], select
the file name “Sample1”

alnix

= t'&l_s!.lals L e gk
HWil=—0ohEriLKk

[roeeice

Fite [ |
Fimdiwe [Crmeen P Fi ool 2] Cmed

Ladder program “Sample1” is retrieved.

vl ]

loea @ en xnn e T
[aaQ SEmERE rnew | —0oBTELK [} SE~ =0t MBERED
CRERES ®ADT B L
- im0

[
B L[4 i
2 et

Pt f
o b e Pl

Use CX-Programmer to read the project “Sample1” saved in the previous section.

In I/O Table Unit setting function, the Unit parameter setting configured in the previous

section is also retrieved.

T | PLC IO Table - NewPLC1

[ O]

. File Edi View Options Help
DOUble-Cllck the I/O - CIM-CPUL3
Table Unit setting 3 towont v
1) 00[0000] CIW-ID21 1(DC Input Unik)
- istor
: 21) Out: 1, In; 9)

¢ 04 [0002] Empty Siot
- §) 05 [0002] Empty Slot
topl 06 [0002] Empty Slet
-1l 07 [0002] Empty Slat
o §) 08 [000Z] Empty Slot
L4l 09 [0002] Empty Slot
4w, [0002] Rack 01

[CIM-CPUIS  [OFfline 4

CI8W-ADON1-V1 [KdR Paranseters]
Onpiayes Pavencts [T ET T *|
L Hem 1 Sotvans | T -
|Inputt input $5gnal use seBing |Enabie | |
Inputz Input gl use Seding Crsabia
Input3 input signal use seding |Besaia |
|Inputd Input 2ignal use seBing [oesatie 1
|Inputs input signal use seding [Ersable |
Inputs Input sigral use Seding Craabia
Input? input sigral use seding |Besatin
JinputE input sigrial use seding [Ersatie
Inputl Inpul range seTing 1-5uid- 20ma,
Tinputz Input range sesing [sFiow
linput3 Input range sezing |1
|nputt input rangu sezing [sr1v
[InpufS Ingut range seting [-Fiov
|Inputs input range seing 10w =l
[~ B B
|
|
|
|
L) =]
- |

et Dighwdts
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Online Connection to PLC I

Debug

am

Verify that PLC model and communications setting created offline and the actual PLC are

correct.

Double-click PLC

3| Settings
: < Memary

Programs

=5 Symbals

E| i:F Function Blocks

) Table and Unit Setup

EI@ MNewProgrami (00)

ﬂ: MCFOZ1_MoveRelative_DINT

b Project /

Check PLC model.

General |

]
™ Fiead Only
CIEC

™| Read Only
File Memor
( MNone = ™| Fiead Only

Timer ¢ Clock.
J7 rstall=dl

(

Make Default

o1

Cancel | Help |

= Sample | - CX-Programmer - [SewPLL | SewPragram | Section] [Disgram]]

Change PLC

Device Man

Devics Type
’V|E‘.J1M t Sellings. |'
Network Type

hmu\hus / t Settings... '

Comment_#® —

Check communications setting.

Network Settings [Toolbus]

Netwark  Driver I Madem |

Connection——————————— [ ata Format
Poit Mame - DataBis. [@ ]
Baud Rate:  |9600 hd Barity: Nane hd
' [V Baud Rate AutoDetect l o Bt l__[1 =

Make Default |
Confirm that automatic
communication speed recognition
is checked.

. [ Bl Bt e Qowst PLC Brogram ook edow Hel =181 x|
Click & | ---------------osc-a-aa-hhn---.mn-‘.w.r asE DmEmswe|a-
a O Q[ m [ AW | — 0L '@ej“" B EEET
(Online connection button) DERROE & 20 10 4[5 | % 9
= B Newhromct '_'le " o Ww. =
?MFI[CIIH]OM [5ecton Name | Section] &
2 Syt .
10 Table: and Unt Setup wiom \w?m winn: AN wings winn |
Sattngs — i 14 44 1 O— -
& Msmny ) [ Pousse ErroxFlag
-1 o
Symboks
. ) ) 1 .. MorveRelative
If a connection cannot be established with the PLC, 4 I— r——
. q - prefelativn DINT s’h |moowy (BOOL) wiom |
you can use the automatic online connection e EM—O_L;J
; fo @ i o
funCtIon' K| G;d Name: Address or Yalue: 'W10.00 Comment; Start Trgges
N m-:lrmmmm Offine. Irurg 000, 0) - 100%

Save your current project data before using this
function because it clears project data being edited.
When USB conversion cable (CS1W-CIF31) is used

for connection, specify the COM port number of the | fre fe tnd B - — 1813
Seocaintr|aias Ll RIRRFEBEER L W B
usB port used. I = dkdrypey | — oo EEELK ||F (S8R T|EBEER
W8 i1 4 4
% - ° o [Program Neme | NewProgram1] -
) . CUwiope wiom Wi WIDD4 wiaos winez |
(Automatic online o e R S
connection button) _'.:I:N_J
. . S Rpogens 1 . Mreheistrie
Serial Port Selection Check: 8 gl G Sovond ’ PO e DR ‘
[PLC] > [Automatic online Boa P ) ey won |
- g = [ Furstion Bocks -
connection | > [Serial Port & v pertson o | [ AT | -
- Prowsct J K| Pasma: o : Wi oo Commant: [StartTroger
Selectlon] fga:!mn 2 Mmcnw:u.m:m-mﬁwm T SMC nngo(o, o) - 100%




Online Debug on
a Machine

Select [PLC] > [Transfer]
> [To PLC]

Click [Transfer All]

Reading a
Project

Online
Connection
to PLC

Transferring
toa
Machine

Transferring to the Machine

Program

Debug

Dan\métfwwm‘m cube HJFF@M;H\m@ﬁ\&,amaﬂm JEAT
& ook Oniline Sirmulator CtrlShift+
e EE pHEELx|[BleE vt mERE |
mEERDE oo 3
— OperatingMade 3 =
NerevProgram?] =
Maritor 3 =
ection’
(84 Compils &ll PLC Programs 7 ]
ML 'ﬂ 10 Table and L Program Check Options... .01 w003 10,04 w00 w2
® e o o [ settings Agtomatic Allacation, . ! 14 {4 14
r&arﬂn‘ﬂ' o o Grgzen Ass‘gnments End Done Abort Error flag —
Errorlog
PLC Clack Function E\n:k Memnrz‘ ®oq, /
< Memory
E %qug;am:  Partial Transfer
éws;:i'; Brotection + R Compare with PLC... e
Clear All Memory Areas
3 Sectior ToFie... 0OL) w1001
& eno Edit P FromFie.. B
- IF Function Blocks = —
NCF21 |
T iy Data Trace, . 20 (INT) (BOOLY w1003
Time Chatt Manitaring. .. Linithio Dane: Dane -
Force » " Ll_l
\, Proisct / et ' Address or Yalue: [W10,00 Comment: [Start

.
®e

Transfer programs and Unit setting parameters created by offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.

[Data to be sent]

CPU Unit: Ladder program and PLC System setting data, I/0 Table data
CPU Bus Units and Special I/O Units:
AD Unit: Range setting of inputs (1~5v / 4~20mA mode)

amplel - CX-Programmer - [[Running] - NewPLC1.NewProgram1.Section1 [Diagram]]
Fle Edt View Insert |pLC Program Tools Window Help

Transfars data to the FLC (downloads) [

[MewPLE1(Met:0,Hode:0) - Run Mode

| 1.8ms [SYNC [rung (g, 0) - 100%

Y

=

')nwnload Options

F‘LE NeWhCT NP
. .
Include ®e Cancel
V% Programis) ®eo,
I Settings ®e
@7 10 table

®e g
Transter All

[ Special Unit Setup
¥ =2 Symbols
Comments

(22 Program index

i~ Symbals, Comments, Program index

Transfer TofFrom: | Comment memary ¥

¥ Transfer files of all tasks

£ Transfer files by the task.

¥ Clzar program memon

™| Exclude Port{Hostlinlk, Peripterall of PLE Settings fror the
tiansfer target
[Check when tansfering CPL it senial camms port setings
changed by NT Linf auto-enline or CRLU unit parameter edit af
[ ntegratar]

Program and configuration data
are transferred at the same time
to CPU Bus Units and Special
I/O Units.

CX-Programmer v 6.0

Transfers all the data to the PLC. Do you wish to continue?

*e** Click [Yes].

Program transfer starts.

F‘!Wam Diownioad o PLC NewPLCT

Demrioad fabed .

CX-One CJIW-0C211

Connection Cable
CS1W-CN226(2m)

&

PLC1
CJ Series PLQ CJ1,
T

 Click [OK].

Next Page

CJ1W-AD081-V1
Unit No.= 21

CJ1IW-NCF71
(CIIW-MCHT71)
Unit No.= 2Hex

CJ1W-DRM21
Unit No.= OHex
Node Address= 01

L ——— CJIW-SCU41-V1

i

Unit No.= 3Hex

O

O

11

4 ~20mA

Connection Cable
XW2Z-200T(2m)

Vi

NS Series PT
NS8-TV00B-V1
System Version 6.0 or later

Sensor

T CIIW-CLK21-V1

Unit No.= 1Hex

Node Address= 01
Termination Resistance
Setting= ON

Servo Driver
R88D-WNO1L-ML2
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Online Debug on
a Machine

[Data to be sent]
NCF Unit: Common parameters, axis parameters

Servo Driver: Servo parameters

From CX-Programmer, display the 1/0O Table,
then start CX-Motion-NCF by [Start Only].

T j PLC IO Table - NewPLC1
File Edit Yiew Options Help

Program
Debug

Then data is sent at the same time to NCF Unit and the servo driver connected to NCF Unit.

-7 CIM-CPU13
[+-4g, Inner Board
-4 [0000] Main Rack
-5 00[0000] CI1W-ID211(DE Tnput Uit
11 01[0001] CIIW-OD2L L{Transistor Queput Unit)
Unit &

L (Uit

W-ADDG1-V1(Analog Input
YNCEZI(Pockion Coptrel

# o2[zz10]CIr

.

*e,
Cle

Chanae | Confirm Units

Unit Comment.

Right-click NCF Unit

# 05[0002] Er

poirts) (Occupancy (Uit @ 21) (OLk: 1, Tn: 9)

@ © gl os[o002)Er
i o fl OP[000Z)Er SysmAC BUS Master
¢ f o8[o002]Er
. - ¢ty oo[on0z)Er  MnitSetup
Point [Start Special g, [0002] Rack g Save Paranetars
A | g ®%ee,, R Load Parameters
°e
pp |Cat|on] oo, mE Start with Settings Inherited
for TTY o
Copy ....o-h%c
e ® Cirl
....C'..Qe\ete
.
e0e®’® °° Uit ManuFactLrng information
o® Uit Errer Log
s Firap Ji-cPUTS  [offine 4

¥ Untitled - Cx-Motion-NCF [_ O] <]
Fle View FLC Lnt Help
D=l adE 0]
e
T =

Press [F1] to display help.

Click [Start Only]

Open a saved project and transfer all NCF Unit and servo driver parameters.
To prevent a servo driver operation using a ladder
program, you must set the PLC to PROGRAM mode

|8 Sample2.mnf - CX-Motion-NCF

Ig@ Untitled - CX-Motion-H I [=] 5|
Blem PLC Unit Help
=2 @6 &
[2]x]
x|« Bk E-

Bl Open
Look jrc | (4 Demo

Click E ecccccoce

{

oo EBLWT o

Open

Click

Select “Sample2.mnf” »
File game( iSamp\eZ ot > | _
|Gl CrFEsmp o © * ° = Caricel L,
A
T [ [ 4\

Press [F1] to display help,

|8 Sample2.mnf - C%-Motion-NCF

Elle Wiew PLC Unit Help

B i o,

U GGIG

Double-click NCF Unit

DM a8 g6

| PLC[C] Series PLC] Online

|

Press [F1]to disp.By help.
.

Double-click NCF Unit.

Click @ |

If it does not go online, click |
and check the communications
setting between the personal

Press

computer and PLC.
|8 Sample2.mnf - CX-Moti 131 x|
File Wew PLC Unit Help
D& e &
E File Edit Onlne Help
&

]
il |ﬂ|>< bt t“"|t5‘|
=g

Amiz 01 Mew Diiver 01(RB80-WNOTL-MLZ)

Press [F1] to display help.

|



Online Debug on
a Machine

Click £I

Online

; Transferring
FleDeantg Connection toa
rojec to PLC Machine

|8 CI1W-NCF71 Axis Map E2

File Edit ©rline Hel

Click

Click [Online] > [Test Run]

Program
Debug

Download to NC Unit B3

Download All [Computer to MC Lnit]

@P

Acquiing Access Right...

=

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK]
button after confirming safety. Also, in the case of communication was not established
between the NCF Unit and the servo driver, confirm the axis number and restore power to

the NCF Unit and servo driver.

When parameter transfer is completed, confirm that communications is performed normally and

has not resulted in an error.

Monitor the NCF Unit. Confirm consistent scan list (axis configuration) and communications
status and that no axis or common Unit error has resulted.

|E8 CI1W-NCF71 Axis Map [ <]

File Edt Onlne Help

Unit monitor - New NC1 [Monitoring {connection established)]

&

1 2 3 4 &5 6 7 8 9 10 11 12 13 14 15816
Scanliet oM oot i ToreTore Y orr Tore vt Torr Lore Tore Jore L ore!Lorr |
e o ore | orr | are | ore | ore | orr L ore] orr orr] ore | orr] are] or [orr ]
Aiyis enar ]

Urit comman erar Enror Reset Al

Enorcods 0000

Enar name

Terminate
Unit monitoring.

Next, perform jog operation. Carefully read the displayed cautions, then perform the operation.
To perform jog operation, it is required to establish a connection, servo lock, and jog setting.

Elle Edt | Online Help
Download ko NC Unit
Upload From MC Unit
Compare

WNOTL-MLZ)

‘Write Flash Memary

Unit Monitar

Device Information

Test Run
- Selected Axis Statu
“ ’VComm om|Eusy B Present Valuel 0 Command Unit
r Establish/Release Connection —JOG Setting:
Speed Designation
’7 5000 Cammand units/s
@E ;[f Fel
see Overide
Established ’7|_ Enable 100 =g
- Servo Lock/Unlock M
—JOG Button——————————————
ﬂ Servo Lock
In Serva Unlock 4 h‘
r Unit common error  Auis ermor
Enor code IUDUD Feset Eror code 0000 Heset |




Online

Transferring

Online Debug on Reading : Program
. . Connection
a Machine Project to PLC Metlgheilne Debug

When using the MCH Unit, transfer data from the CX-Motion-MCH to the MCH Unit and servo
driver connected to the MCH Unit.

[Data to be transferred]

MCH Unit: parameter, position data, program, CAM data.

Servo driver: servo parameter

Display the I/O table from CX-Programmer and start CX-Motion-MCH with [Start Only].
(Refer to NCF Unit for starting from the 1/O table.)

Open the saved project and transfer Unit parameter, position data, program, CAM data, and
servo driver parameters to the MCH Unit.

To prevent a servo driver operation using a ladder program, you must set the
PLC to PROGRAM mode.

g%

File_wiew Took Help

u
CIICk E‘ EEEEEENEEEEEEEEEE d
[ B RS B 5 B X A

zlx|

=« @t E-

Select file .mnh

-

I\ Project /
CI|Ck[Open] ....-............3‘ H
Ef
WA TR, Compite A Transfer /-
Edit 4
Click {3, Berrmas e
118 5ample5 - CX-Motion-MCH =lglx| |

H File Edt Wew [nsert Online Tools mnduwgﬁilp
I:j DeH drRErr[Tulnun| e

Click

If it does not go online, double-
click PLC in the project tree and
check the communication
settings between the personal
computer and PLC.

ImEEa

ErfE NewPLCT Transfer Data To MC Unit

B f) TagetsIou (3)

~Select MCH A

Parameter
Ui Selings o w < = AlData
i Pl wim = ® peened Data
aammmsnu®f =" NewTask1 [1] A Systen Parameter
gumumunt® (- My Awes
Select [All Data] | [ Moo Frograms -
=2 Puogams o o AR i Servo Persmeter
F B NewProgiamd (1 © Wilhow Serv Parameter
B NewF:Dalun.[H
5.7 euPlgiams I \FostioDa
Lansm® - NewSubProgram500 (I [sien Dtz |
" s CAM = Program
ans® -
Select [\Nth S annet® - B Heatabti () | £ Individus!
elec | ervo -
Parameter] - -
Froject
5‘ -
Ij 2 [E ek Data | H
i aEEEEEEEEEEEEES . Cancel
EEEEEEEEEEEEEE EEEEEEEEEEEN =
Click [OK] e quq VT Compile {Transter 7
it ‘ [ [ontne

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK] button
after confirming safety. Also, in the case of communication was not established between the
MCH Unit and the servo driver, confirm the axis number and restore power to the MCH Unit
and servo driver.
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Transferring NS screen data

Start NS transfer

cables.
program

From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer
Ver.1.0] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer]
> [CX-Designer Ver.1.0].) Open a project saved in the previous section.

| This section describes how to transfer screen data to the NS through PLC without changing

Select [Transfer]-[Transfer[To PT...]] from the [PT] menu.

x|
*Communication between the NS and the PLC
Do you want to start transferring? B .
q . must be established before transferring screen
Settin . : . >
Click on ﬂ Steeenn. ) [ data through PLC without changing cables.
Ce Frangfpr Seﬂmg
If “Connecting...” is displayed at the right bottom
Mo setting Setting
[ of the screen, use Auto Connection (See Chapter
I™ Do not show the dialoe aeain. 3 1-3 “Setup NT Link”) to connect the NS and the
PLC before starting the following procedure.
Setup - If the communication between the NS and the
communication route CTrE— 5 PLC has already been established, you do not
et st v - need to perform the operation described above.
esooe Lt
Check “Pass thru PLC” .eeeseessesse®®® Pl s
|n_tr<lje Comm. Method (L T Check “Pass thru PLC” to activate
winaow et o R R R “ ” :
. A [owed  |= the “PC - PLC - NS” route setting.
Erom 3] 5] : (1 awera :‘r:‘: : - Comms. Route
11 ' : R S
. EHENE R ot
E T | N | E ® FE[———]FLE—‘—[Nstwnll}]%]—PLE——N‘3
: :
contd [ " G0 * Select PC - PLC - NS.
[vintoing B3|
Select Serial(Toolbus) . Setup “Data transfer to | 3 deeeee Setthe serial port
".... the NS thl’OUgh PLC". e | COM No. for PC
See e, . - Diata ianster to the NS thiough PLC :_‘::5';; [Enectwe =] 9 PLC Connection.
o e Then, press OK.
® [SerialTookbw: vl Set(C)
Select NT Link «., ! J L
Press each setting button.
Teee.,, T
Fart H‘5232E ]
. «eeee Enter NS Unit No.
Then, press OK.
Transfer screen data I T
x
Autoreset afver the hanamision Comma. Poute Transfer|[Computes->PT]
Click OK to start transfer 7 P rough L
et “ rithuhs Yk 3
.', I PC o
.0. n Fer to N L Dt sansber bo the NS theough PLC. w“m-m
.'o T | _I ul.‘wm
° Senalootu | SeL i)
' S s |
° (2o, Motod

] Screen data transfer is
Cmcey | e | complete at 100%.




Online Debug on Reading c og:gr::ﬁon Trantzfzrring Program
a Machine Project to PLC Vel Debug
Program Debug I
Transfer programs and Unit setting parameters created by an offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.
Monitoring
Monitor ON/OFF status of contacts and coils.
_— M gamplel - CX-Programmer - [[Stopped] - NewPLC 1.NewProgram1.Section1 [Diagram]]
X m Fle Edit Wiew Insert PLC Program Tools Window Help P =1 x|
Click = rem e gy (e[ 0 e o e g 45 e e Ne o o 45 e e B R iy R B (S w2

aoQiSEmERTrvwew | —opaEelx||[ESm|w%w s |wWFEED |
DERROS |H= P Bns v

=

CX-Programmetr ¥5.1 1]

Make sure that there aren't any problems if the PLC is started.
Do you wish ko switch the PLC inko Monitor mode?

(4

Click [Yes] |EEEEmsEEEEEEEEEEESE

|n:\rn"- ... ON/OFF of monitoring

EEEEREEET R

=zl fo e e (el
%8 HewProject o
= CI[CILM] I = [Section Name : Section]
‘= Symbols
10 Table and Unit Setup AH0.00 w10.01 W10.03 10,04
Settings 0 i 14 | Frame color changes to
(B Memary card StartTrigger ENO Done ified I ol
(B Ervor lag T a specifiea color auring
) PiC clok — Function Block execution.
< Memory Stanz
2 % programs i MoveRelative
1% MewProgram1 {003 Running 7
52 Symbols _NGFO21_MoveRelative_DINT
-5 sectiont P_On (BO0L) (BOOLY
=il ] En ENO! i
B JF Function Blocks Abways OM Flag
~AF _NCFO21_MoveRelative_DINT
20 (INTY (BOOL) WA 03
—Unitho Danef Done
o
& (T |ooLy| w04
Ao Command_A8 | Pause
ortedt il
(B00L) gooL)| w008
{Execute Erorl  Errorflag
a
(DINT) (AORD)
Distance ErroriD b
Current parameter lonrs
value is displayed. Rt
=
Ll | ;
', Project / x| [ Global  Mame: Address or Value: [W10,00 Camment: (StartTrigger
Far Help, press F1 [ [MewPLC1M=t:0, Nade:0) - Maritor Made [ 1ems [svnC [rung o, 0) - 100% [ Z




Online Debug on
a Machine

Move the cursor to D100
of input parameters

Right-click, then select
[Set/Reset (S)] > [Value
(V)] from the pull-down
menu

or

Double-click

Or

Reading
Project

Online
Connection
to PLC

Transferring
toa
Machine

Program
Debug

Monitoring -2 Changing the Current Parameter Value I

Change the current value of contact or channel through conductive monitoring.

o

L]
l.....

=

[Program Name : NewProgram1]
[Section Name : Section]
wi0.00 VD01 w1003 WHD.04 w1005 w0z
— | | | i1 1 1
StartTrigger ENO Done Fause ErtarFlag
w002
—
Stert2
MoveRelative
_NCFD21_MoveRelative_DINT
P_On (BooL) (BOOL) W10.01
Er ENO |
Alyvays ON Flag
50 (T (BooL)|  wino3
Alnitkia Dorel  pane
i
&1 (nT) (ool winod
Jaxis Command_&h - pause
orted 0
N ABooL) (BocL)|  winos
ecute Effort  Errorflag
] i
(DINT) (WORD)
{pistance Erroril |-
&2000 (DINT)
Jielocity

Change current value of the input parameter.

Set New Yalue [ x|
N
o

Address: |w1 0.02 Set

>---------- C||Ck

Doata type: I BOOL - l nce
v : Ensure to add "#" (hexadecimal/BCD)
Walue: I )
or "&" (decimal) to the left of the value.
0. 1(0CH]
0 [Program Mame : NewProcgramd ]
[Section Mame : Section1]
10,00 Wi0.01 Wi10.03 10,04 W0 .05 10,02
— | | 11 11 11
StartTrigger END Done Pausze Errorflag
w1002
Start2
MaveRelative
7
_MCFO21_MoveRelative DINT
P_On (BOOL) (BOOL) w001
EN ENO) |
Blyways OM Flag
&0 CINT) (BOoL) W10.03
AUnitha Daone Dane
o
&1 (INT) (BOOL) Y1004
Az Caommand_Ak | PaLse
orted i)
(BOOL) (BOOL) W10.05
Execute Errork  Errorflag
o
(DINT) (WORDS
Distance ErrotiD |
42000 (DINT)
JNelocity




Start-Up /
Adjustment On-
site

Move the cursor on the

circuit you want to modify =========

You can use drag-and-
drop to specify more than
one circuit at the same

Program

Modification

time

Select [Program] >
[Online Edit] > [Start]

Shortcut [Ctrl]+[E]

Move the cursor on the
contact you want to modify
and double-click

UG

Select [Program] >
[Online Edit] > [Transfer
Change]

Shortcut
[Ctrl]+[Shift]+[E]

Unit
Parameter
Change

Online Program Modification (Online Edit) I

[Program Name : NevePrograml

[Section Mame : Section |

Wi 0.00 WD
L '

1

WHO.03

WA0.04

Wi 005

W02

} !
StartTrigysr MO

¢UEEEEEEEEEEEEEEEEEEEEEEEEN)

Done

Pause

ErrorFlay

0 o | [ Preuram teme : NewProgram1]
[Section Name : Saction1]
W 0.00 W0 W10.03 w004 Wi00s w02
! 1 1t O
StartTrigger ENG Dane Fause ErrorFlag
w002
Startz
3
7

w1002
Start2

22000

52000

-{ )- Edit Coil

_NCFO21 _MoveRelstive_DINT

(BOCL.
Command_ab
orted

w1004
Pause
[

(EIOOL?. w1005

Erral

(WORD
Error

Errorflag
0

|w20. iy

=

AammmEE®

| s tame  Newkrogram)
[Section Name : Sectiont]
w000 W0 01 w003 wiaos w005
14 <
StartTrigger ENO Done Pause ErrorFlag
w002
Stariz
3
7
_NGFO21_MoveRelstive_DINT RELELEE LN
P on BOOL) (BO0L - .
T} N ENO:
Always ON Flay - -
¥ < . "
a0 ) @ooLy[  wioos . v
Cinitilo Bor Dot ammEmmEs
I
a T oLy wioos
xis Command_ak Pause
oted 0
wingz  |mooL) ©ooL)  wioos
Start2 recUte Errol ErrorFlag
1 [
az000 DINT) {VWORD,
istance Eror
2000
>

Double-click |



Start-Up /
Adjustment On-
site

Click E

(Online connection button)

Select [PLC] > [Transfer]
> [Compare with PLC]

Click [OK]

Click [OK]

Unit
Parameter
Change

Program

Modification

Verifying Program I

After modification on-site, you can verify it with the designed program and display the
differences graphically. This allows for easier checking of the parts modified on-site.

1. Read the designed program. In this example, read “Samplel”.

Then connect online.

h#U R an tue
e
oES

¥

L

BT,

s 5 e

Program Compare with PLC NewPLCY

=5
a2l
BEARAFEETER ~w %
Miment g e

CX-Programmer ¥5.1 E

@ Compare Failed

You can check FB parameter

Click [Section (1)] > ﬁ;ﬂ A )

[Mnemaonic View]

3. Display the verification result.

differences.

L)
8% Compare Result - [ Current Project - Connected PLC ] =] E3 % Compare Result - [ Current Project, - Connected PLC ] M=
Eie  View Ele Yiew -
B 1 i
Ll EA P overview |1 %
-
[Current Project] NewPLCL [Connected PLCT [Current Project] NewPLCL wConnected PLCT
MewProgrami (00) MewProgrami (00) MewvPron e Pr
B oectont T Sertion () L | A
@ Section (2) 00001 [AMD A 0 01 » 0RONT |AND W0.01
00002 (OR w002 [ ] 00®02 (ORwW10.02
00003 [AMDROT v10.03 - DEII!‘JB ANDNOT W10 05
(poowos [averior oo T
=
nog¥ Lo cF113 0000EFLD CF113
0G003 [FBCALL &15 00007 FBCALL 415
180008 [FB_NPUT &0 00007 [BE_INPUT &0
00008 |FE_NPLT &1 00007 [RE_INPLIT &1
¥ paooge [FENPLT W 0.02 00007 [FE_INPLIT 141 0.02
S 0000& [FE_MPUT &2000 00007 |FE& INPUT &2000
* 00008 (FE_MPUT &2000 noon? FEFJ-NPLIT A2000
.. I0000& [FE_OUTPUT vi10.03 00007 |FB_ HUTPUT w1003
o = =
,’ 0000 [FE_OUTPUT ¥W10.05 00007 |FE_OUTPUT w0 .06
* 00003 [FEEND 00007 |FBEEMD
" 00008 | AND WA0.02
4 e Lo
*
* —
‘ K 2 « | i P | NI
For Help, prass FL | same | oif  [Wimevednl IETEENE For Help, press FL !l Same | Dif  [L0eved
‘. . ¥ >
* ““
.
You can check ladder contact It
. .
.
address differences. Lot
o
“

In addition, you can check add,

delete, and move contacts, coils, and

apply instructions.




Start-Up / Unit
; Program
ARSI 1 Modification 4 Parameter
site Change
Unit Parameter Change and Verification I
After modification on-site, you can verify it with the designed Unit parameter and display the
differences graphically. This allows for easier checking of the parts modified on-site.
1. Read the designed program. In this example, read “Samplel”.
Then connect online. (If you have already read it in the previous section’s operation, this is not
required)
Click [I/O Table/Unit Open the 1/O Table/ Unit setting, then double-click the AD Unit.
Setting] 1o TNt e |
bt Wew Ootions Heln
B oo Dichyed oot T -

g, Inner Board

00007 Main Rack
ﬂl|| m:um Tw 1021 1 [ I Bl Vahu T _unit_| -
. f 1 £ Input! Input signal use seming Enal
Double-click the o g I slonal 266 L4tg Bisan
. . Input3 Ingut signal uge setling

registered AD Unit et bt Lt Lt 11 Inpu nput sl use ssfing

T 05[1525] COW-CLEZI(Controlier Link Linik) (Lind 1 1) Inputh Ingut signal use seming

T 05 [1575) COIW-S0UM1-V1{Serial Communication LUnk) (Unk : 3) Ingulf Input signal use setling

T 07 [0002] Erply Skt Ingut? Input signal use seting

1 08 [DO02] Bty Shat Inguts Ingiut Signal s Setng

T 09 [D002] Bty Shat Input] Ingut range semng

¥ dgy [0002] Rk 01 Inputd Ingut range seming

Input3 Input range Seling
CUM-GUI3  Pregram Inputd Input range semng
Inputs Ingut rang 5eming

oot e =
Help:

- g

d R

. Treafediek oPE] | Tmslmmuml Compare . Beset |

Click [Compare] button sangats | — ] e |

2. Click the [Compare] button.
Now you can see the difference between the designed Unit parameters and the configured
parameters in the machine.

Edit Parameters
Edit Parameters

s ) (7 5

IComparing parameters
[Fompare unsuccessful (2 mismatches)
>

Click Cloze | You can check the

number of unmatched

items.
3. Unmatched detail differences can also be checked.
Displayed Parameter[Al paaneters = ‘ o Unmatched items are
-
st o 3
Item Setvalue Read Value (Compi+| || o ® Le ‘o’ ShOWn n Orange'
Input! Input signal use setting Enable Disahle .® PS
Input2 Input signal use setting Disable Disahle **
Input3 Input sighal use setting Disahle Digable .’
Inputd Input sighal use setting Disahle Digable "
Inputs Input signal use setting Disable Disable ’0
Inputd Input signal use setting Disable Disable b
Input? Input signal use setting Disable Disahle .’
Inputd Input sighal use setting Disahle Disable .’
Inputt Input randge setting 1-9Vid-20m#A +H-100
Input2 Input range setting +-10% +-104
Input3 Input range setting 10V A0
Inputd Input range setting 104 10
Inputs Input range setting +-10Y 10 =
Hep After checking the
4l Al q q
unmatched details, Unit
. .
L.s=®*""" parameters can be easily
pue® aR
= PPTLLL modified.
a
.
' TransferfUnttoPC] | TransfelPC to Unif l Fsst
Set Defaults oK Cancel

You have now completed Chapter 2: Example of PLC System Construction by CX-One.
The next chapter describes PLC network construction flow.
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Example of PLC Network System Construction by CX-One

Workflow in This Chapter |

This chapter describes an example of PLC network System construction from start-up to reassembly and on-site

adjustment as shown below.
This chapter mainly describes how to start up the System using CX-Integrator, an integrated start-up Support

Software for various PLC networks.

Start-Up

PLC DeviceNet \|  NT Link | ©MOIe\Jcompoway
Start-Up Start-Up Start-Up Start-Up /F Start-Up
Start-Up

¢ Describes details from assembly and wiring of PLC
System to program download for a trial run.

¢ Target of Start-Up
Aims at removing the cause of errors from a PLC
and to turn off all of red LEDs that indicate errors for
any component of the PLC System.

¢ Saving the entire system configuration after
completing start-up is recommended. You can utilize
it for system adjustment on-site after delivery to
reduce the adjustment period.

System Configuration I CIIW-CLK21-V1

CX-One

CJ1W-DRM21

Unit No.

Node Address =01

=0Hex

Other Settings = Default

CJ1IW-AD081-V1

Unit No.

CJ1W-ID211

PLC1
CJ Seri

Unit No. =1Hex

Node Address =01
Termination Resistance
Setting =OFF

CJ1W-SCU41-vV1

=21 Unit No. =3Hex
PLC2
CJ Series P

=

Saving
System
Config.

Delivery

. \
Equipment

[}
[}
| Disassly/
[}
[}

Reassy ,

Adj. On-site
e Describes details from disassembly of a system for
which the trial run, delivery, and reassembly on-site as
well as operation check have been completed.
¢ Target of Adjustment On-site
1) Confirm that no error will occur in its electrical
system in the same system configuration as that
before delivery.
2) Confirm that no discrepancy will be found in
Controller Link network settings by connecting to a
network on-site.

Connection Cable

Connection Cable

CS1W-CN226
(2m)

7

XW2z-200T

NS Series PT
NS8-TV00B-V1

System Version 6.0

or later

4 40

.
.
.
)
.
.
.
.
.

« Setting

Routing Table
(Local Network Table )

CJ1w-0C211

CJ1W-NCF71
Unit No. =2Hex

Unit No.

Network
Address

1

1

2

2

Note) The Local Network
Table is required in order to

attach more than one
network communications

Units.

|D
I

1G- CPU45H CJ Series P,

CJ1W-DRM21
Unit No. =OHex

>

Node Address =04

CJ1IW-CLK21-V1
Unit No. =1Hex

Node Address =02
Termination Resistance

Setting =OFF
PLC3

Ad;. On-site>

System
Config.
Verification,

Controller
Link
Diagnosis

CJ1W-

DRM21

Unit No. =OHex
Node Address =05

CJ1G- CPU45H

&
4]
4]

|D
I

Servo Driver
R88D-WNO1L-ML2

\

Compoway/F Network

O

DeviceNet Network Address = 3

125K bits/sec

Use at

— CJ1W-CLK21-V1

Unit No. =1Hex

Node Address =03

Termination Resistance Setting =ON

E5CN-CQ203T-FLK
Unit No. =1

E5CN-CQ203T-FLK
Unit No. =2

DeviceNet Network Address = 4

Use at I

125K bits/sec
|

1/0 Relay Terminal 1/0O Relay Terminal
DeviceNet Network Address = 2

Use at I

125K bits/sec

1/0 Relay Terminal 1/O Relay Terminal

1/0 Relay Terminal 1/O Relay Terminal



PLC Network PLC DeviceNet NT Link CoEitrr](l)(IIer CompoWay
Start-Up Start-Up Start-Up Start-Up Start-Up /F Start-Up

PLC Network Start-Up

System Controller
Config. Link
Verification Diagnosis

Online Connection to PLC (Automatic Online Connection) I

1. From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Integrator] > [CX-
Integrator] to start CX-Integrator. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-
Integrator] > [CX-Integrator])

Starting CX-Integrator

8 DR e et e Gt ot e

:uu u; ',-.“,—J
AW » Integrator
Version 1.0
Lodl 7

CX-Integrator starts and automatically connects online.

Jsert Mebwork Component Tools  Windows Help

Click %

s on e B e sn J.@,f@ %] L5

o

i)
=] ]

Select a serial port,
then click [Connect]

EZERpdde*BEESEE

Select a serial port.

When USB conversion cable (CS1W-CIF31)
is used for connection, specify the COM port
number of the USB port used.

(Important)

This operation is used for online
connection to any PLC hereinafter.
Unless described otherwise, use
this operation to connect online.

Auto Online

Goes online automatically.
Select connection type and press [Comnect] button,

—~GConnection type

& Ser\al)connect\on(including the case when using USB-5erial conversion
cahle

Bl ety 4 R

s )

¢~ U3E connection

t will be connected with the PLC connecting to the PG with the serial cable
automatically,
[t i= not possible to use it for the CompoWay/F device.

Supparting PLGCSASJSGP series

T aRnect Gancel

All communications Units and ports of
a connected PLC are automatically
displayed in the online connection
information window.



Controller
Link
Diagnosis

System
Config.
Verification

Controller Saving
Link

Start-Up

PLC Network PLC
Start-Up Start-Up

DeviceNet NT Link
Start-Up Start-Up

CompoWay
/F Start-Up

System
Config.

Checking PLC Error I

CX-Integrator

Errors are inspected in the target PLC.
Please check the content of the errors by "Display E&sror Log" befare executing Online functions.

(1) Remove the cause of the PLC error, then make it available to run.

N 3] Het{0). Mods(0)

Move the cursor on the ====
PLC and right-click

Start Routing Table

Select [Error Log]

(2) Check the PLC error.
Examples of 10 settings error and CPU Bus Units and Special /O Units number overlap error
are shown below.

B PLC Errors [_ =]
File Options Help
Enors | Ever Log | essages | You can check an error in a CPU
lem | Code | Staws | Detals I Unit and error history.
gg; S e tumos Dupteston En. (You can use the same function in
the error history of CX-Programmer’s
online screen)
[cam-cPULE Run [Clock: Mot Monitaring

=

(3) Solve the cause of error.

You must solve the problem through the following procedure:
- Set the PLC to PROGRAM mode (in which you can change settings).
- Change the rotary switch of the CPU Bus Units and Special /0 Units (make sure
that it does not overlap).
- Create the I/O Table.

¢ Set the PLC to PROGRAM mode.
From step (1) above, select [Mode Setting] then [Program] mode, and click the [Set] button.

| = Orline Toolbus COM1,9500,Mone,8,1 [CI1

M-CPU13] Net[0], Nade(0]

T [N a1 rqet PLL [ 1M-CPLI1 3] Neti0], Node(D
‘g CPUPort [CIIM-CPUT 10 table
Error Log
Start Routing Table
PLC Mode Sektin: X
W ] CX-Integrator [ <]
Mode Address: 0 CIM-CPUT2

Please confirm there is no problem even if stopping PLC execution.Is it Ok ko change ko
SkopfProgram Mode?

i~ Run I Set

€ Debug Read -
‘e
Online Status:

. .
|Mode Command has been completed Click [Yes] .

LCloze

= Maonitor




PLC Network . : Controller Saving System Controller
AR <o 4 StrUp 4 SwiUp oK/ iFSiarup 4 Ssem Config.  J _ Link
Start-Up Config. Verification Diagnosis

e To change the Unit number change the rotary switch of CPU Bus Units and Special I/O Units

and restart power. o

e Check if any error occurs in the PLC (CPU Bus Units and Special I/0 Units number overlap

error should be solved).

x| = g Online Toolbus COM1, 9600 None, 8,1 [D.HM CF'LHE] Net[0], Mode(0)

[l E--E‘E Target PLC [GI1M-CPUT3] Het0l 1

<y CPU Port [CHM-CPUT 10 table

Ex PLCErrors
File Options  Help

Enors | Erior Log | Messages |

Item Code Status

@071 [ Fatal

Detals
10 Setfing Enar

Start Routing Table

e Create the I/O Table.

x| = g Dnhne Too\bus CDM1 SBUU Mone, 8,1 [CJ1M- CF'LHE] Net[0], Mode(0)

|
ety CF’U F'Dr [EJ1M CPUW
—Errortog———— "
Made Setting
Start Routing Table
T § PLC IO Table [_ O] x]
File Edit Wew | Options Help
-% ©IM-CP  Transfer to PLC M
g, Inner Bo.  Transfer from the PLC
g [00001M  Compare with PLC

g, [0000] R

Werify

Delete

Hat Syap

Rackislot start Addresses
Units Profile infarmation
Dip Switch Information
Change ETHEL Mode
Consumption and Width

Start Special Application  »
Compare with Braject
Check

Create Registe[CIIM-CPU13  [Program 4

7§ PLC IO Table
Fle Edit Wiew Options Help

4, [nner Board
=44 [0000] Main Rack
-4 00 [0000] CI1W-IDZ11{DC Input Unity
5] 01 [0001] CI1W-0C21 1{Relay Output Unif
-4 02 [2210] CIIW-ADDB1-Y1 [Analog Input L|
5] 03 [1550] CI1W-NCF71{Position Contral L
-] 04[1500] CILW-DRM2 1(Dsvicshst Mastsr]
5] 05 [1525] CI1w-CLk21{Contraller Link Uni
1 08 [1575] CILW-5CL41-V1{Serial Commun
1 07 [0002] Empty Slok
- §) 08 [0002] Empty Slot
-1 09 [0002] Empty Slot
&g, [0002] Rack 01

< »
CIIM-CPULS  [Frogram 4

e Check if any error occurs in the PLC
(all errors should be solved).
x| = @ Online Tuu\hus EEIMT EEEIEI Nnne 81 [EJ1M EPU13]N5I[[I] Node(0)

-.f.- CF‘U Port [CJ1M EPLH

IO table

Start Routing Table

|Clock: Kot Monitoring

[cam-cPu13  [Run

[ O[]

T | PLCIO Table
Fle Edit ¥iew Options Help
%l CIIM-CPUL3
gy Inner Board
[0000] Main Rack
&g [0000] Rack 01

",.,,.,

[caim-cPU1E  [Run 4

PLC IO Table [ <]

& Are you sure you wank ko create the IO Table 7

PLC 1D Table [ <]

& Initialise CPU Bus ssttings ?

Click [Yes]

Transfering...

The I/O Table is created and
Unit configuration is displayed.

¥ PLC Errors IS E3

Fle Options Help

=

Enors | Ermer Log | Messages |

Itz [ Code [ Status [ Details |

Mo Enrors

|clack: Mot Monitoring

|Cam-cPULE  [Program




PLC Network PLC
Start-Up Start-Up

Saving Controller
Link

Diagnosis

System
Config.
Verification

DeviceNet { NT Link 1 Controller

Start-Up Start-Up Stla_llr?-lth

CompoWay
/F Start-Up

System
Config.

Confirming the Routing Table is not Configured I

Re-connect to a PLC (1) Check that Routing Table is not configured.

with CX-Integrator 2| == Online Toolbus COMT 9500 Mane, 8,1 [CI1M-CPU13] Net(0). Node(0)
T (= cnnl T - et PLC [CJ10-CPUA 3] Neti0), Node()
-ty CPU Part [CHM-CPUT3]Net), Hodsl-] | Lrit-) .
= DevioaNet [CITW-DRMZTTH2), Node(1), ORMON =21 2 Check Rauiting|Tiable
-2 Controlle Link [CJTW-CLK21] N1 Noeett], Urit1) presence. If the Routing Table
g SO Port [CJ1w/ASCU41 31 ] HEET Mode(), Unit[3) is not configured, create one.

=

2 Conflgure the Routing Table.
x| E-" [l b = il klet(0), Node(d)
Move the cursor on the = ====sk= CUMCELI 2T Het0] Ko

PLC and right-click — T
= Dewvicel  Error Log

:@ Controll  Mode Setting

Dd'e['l 1. Unit[0)
Mode[1], Unit(1]
ode[-], Unit[3]

Select
[Start Routing Table] amamus

Skart Routing Table

1 PLC Routing Table M= E3
File Edt Optons Help

MEEE R

=47 CUM-CPULS A ] =
g Unit 00
g, Uit 01
g, Uit 02 af1|2(3|4|5]|6(7|8]39]|10(11]12|13|14[15
gy LNt 03
gy Unit 04
g, Uit 05
g, Uit 06 i
8, Uit 07 |
gy Unit 05

g, Uit 09

g, Uit 10

g Uit ]

g Unit 12
g, Uit 13
gy Uit 14

i 15 T =
R | | | all

510U [ Hetrork Main View [ Duerview | Table View |

CIIM-CPUIE |Metwork:D Node:0 [Program
Right-click and select local (3) Edit the Routing Table and transfer to Esmun -
network (Unit) [Insert CPU e
SIOU] or local network (port) Insert CPU SIOL e F =
[|nsel’t EORT] Inserk EORT Local Network Number _I::l

—

Set the Routing Table as shown below:
¢ Assign a network number to a Unit number.
Enter its local network o A Unit number can be checked on the online information window.
number, then click [OK] « Assign a network number to each network.
The Controller Link network number is same for other PLCs.

(4) Check if the error is solved.
¢ Re-connect to the PLC.
¢ All errors should be solved and no error messages should be displayed.
e The network number is displayed on the communications Unit.

Reconnecting CX-Integrator



PLC Network PLC
Start-Up Start-Up

Right-click a DeviceNet
Unit under Target Device
in the online connection
information window, then
select [Connect]

DeviceNet NT Link
Start-Up Start-Up

Controller
Link
Start-Up

Saving

Controller
Link
Diagnosis

System
Config.
Verification

CompoWay

/F Start-Up 4 System

Config.

DeviceNet Start-Up I

Remove DeviceNet communications errors and establish communications.
= Check DeviceNet Unit's 7SEG indication and ON state of MS/NS LED.
= Check Slave Unit configuration trough CX-Integrator.

Create a scan list of DeviceNet and determine the memory map.

(1) Connect to PLC online, then connect to DeviceNet through the online connection information
window.

_| =1 . Online Toolbus COMT 9600, None 8.1 [EJTM- CF'LI13] Met[d), Node(d)

Start Data Link
Start Routing Table

=

(2) Next, upload the network configuration information of DeviceNet.
_I =- . Orline Tnolbus CEIM1 SBEII:I Mone, 8.1 [DHM I:F'U13]Net[EI] Mode(0]

n] et [, [
Iy Controller L  Unit(1]
22 SCU Port [ ()

Connect

Stark Maka Link
Skart Routing Table

Cx-Integrator

Please transfer the network parameter for each component if needed because they are not transfered here (in the

case of Contraller Link and SYSMAC LINK),
Do you wish ko continue?

In this example, although one Master Unit (hode number #01) and two Slave Units
(node number #02, #03) are actually connected, assume in this start-up example that
one Slave Unit (#03) is not connected due to disconnection.

& Mebwork structure{Metwork No.:2) will be tranferred.

(3) After transfer is confirmed, connected devices on the current DeviceNet network are
displayed as shown below.

= ||

#01 #02
CJ1W-DRM2T  DRT2-1076+HM..

e | ;

Check if a Slave device on the remote I/O
communications actually wired is

recognized. Master Unit (#01) and Slave
G Unit (#02) are recognized, while another
Slave Unit (03) is not recognized.




PLC Network . : Controller Saving \ System Controller
AR SiUp 4 StniUp 4 SwtUp oK/ FSiarup 4 Sysem 7| Confo 1 Link
Start-Up Config. 4 Verification Diagnosis

Right-click on the Master (4) Check the error on the device monitor screen. e

st e

Unit icon and select b ] s e ., F Tt e
[Monitor] to display the You can check the Slave status on Pt T r
device monitor screen. the device monitor screen as well. %gggg%i oo I3
Select [Status] tab el e T

Slave Unit (#02) is recognized, while the
other Slave Unit (03) is not recognized. =3

A"

(5) Wire Slave Unit (#03) correctly.

(6) Re-upload the network configuration information of DeviceNet.

Perform the Step (2) from . Network 1{DeviceMet) #002) M=l E3 |

the previous page

Now it can be confirmed that Slave
devices on the remote 1/O

#01 #02 communications have been recognized
CIIW-DRM21 DRTZ-ID16+%W. .. DRTZ-0D16+X... . .
and communications have been
established.

(7) Configure DeviceNet remote I/O communications (free assignment) and register the Slave
to the Master.

Double-click a Master Unit

hcbevce pramerers £
(CJlW-DRM21) Icon Commurication Cpcle Tine | MeasspaTimae | ShaweFunction | Commricalion Cycte Tare | Message Tines | StaveFurmtion. |
Geneial | v L T 1 1
Uriegitses Device Litt Uraegitnss Davics Lis
¥ | Produci Hame [ Owsice [inSze | # | Product Name [Ousee [insee |
i DRTHDESWTIDIE Ue Al
&P 103 DRTZO0IEWT-ODE ABwe Dy

Two Slaves are now registered to the
Master.

Click twice ....--------l--:q;::’::;. I At sheeion s o egiened . L L e st stocrian s et
| Puodue | Ouses |Owch [intes |inch [ C | PP P e P e ———
lj oz DRTZ. OBpe Ay FI0ER..
P03 DATZ. ADpe  J2000%. ODpe
. £t | Fep | Abvarced Sep Riegistea/Inangisherd
CI|Ck the [OK] bUttOnlllI---.....m..gm..ﬂﬂfl LTI WUoload | LRovmizad I Lompae |
K el "EEm L LN NN e Concel
(8) Configure assignment of Slaves to areas of a CPU Unit.
Right-click the Master Unit If necessary, configure the Slave parameters as well.
and select [Parameters] > e N |
[Edlt] |'xr.;.:::m...mhh.;1 | . uwl...i |m Sl Funcin |
_ow |
Dete <Master Unit parameter edit dialog box>
L.
Ij Liptsmsten |
Memosy Dlock. 1 Memoy Block 2
m Ch | Pruscact Hanner |ﬂ h [
W 00000 HOJDAT2..
W E0000d  HOJDAT2..
W 00000 HOJDAT2..
W E0000D HOJDAT2..
L e i)
Edit the parameters, then =
click the [OK] button =i
Treay, 2 =l
I .s'ﬂﬁ-.... sene. |
“u,
e )

Select [Network] >

(9) Start remote I/O communication.
[Transfer [PC to Network]]



PLC Network
Start-Up

PLC
Start-Up

Right-click a CPU Unit
under a connection target
PLC in the online
connection information
window, then select
[Connect]

Controller

DeviceNet NT Link ink CompoWay Saving Systfe'm
SitUp 4 Sutls | gil, FSlanp ) geem

NT Link Start-Up I

Remove NT Link communication errors and establish communications.
= Release NS Connecting . . . message.

= Check NS configuration through CX-Integrator.

Controller
Link
Diagnosis

(1) Connectto PLC online, then connect to a CPU Unit through the online connection
information window.

x| == Onli
4 gem

mumn Conneck

Shart Data Link
Skart Routing Table

MT Link Tool
Controller Link Tool 4

=

(2) Select in the order from upper link port to NT link.

Selected Itern  CPL Port[252] : Serial Port

CX-Integrator

Selected ltem  MTLink

Select the item from the following list.

Select the item from the following list.

| EomEDWaiF

Cancel

' Cancel

' oK i'
(3) Next, select [NT Link Tool] > [NTLink Auto Online Setting] from the CPU Unit.

2| == Orline Toolbus COM1,9600, Mone, 2.1 [CJ1M-CPUT3] Met(0), Node(0)
T [N coal 7 1t PLC [ M-CPLUH 3] Net{d), Node(0)

1 CPU13] Met(-], Model-], Unit[252)
Made(1], Unit{d]

1), Made(1], Unit(1]

, Wodel-), Urit{3]

Transfer[Metwork ko PC]

Connect

Stark Data Link
Start Routing Table

T Link Tool
| Controller Link Tool 3
4

MTLink Auta Online Setting

|+

Automatic NT Link connection function is used to automatically connect NS series PT
and PLC via serial connection (NT Link). Connection is automatically performed by
overwriting the PLC serial communication port settings by adjusting to NS series PT

settings.




System Controller

PLC Network ; q Controller Saving
USRI SiUp ] StartUp 4 SwrcUp 4 oK JiFStarup 4 System Config. ¥~ Link
Start-Up Config. Verification Diagnosis

Cx-Integrator E
& Changes CPU the setting of R5-232C Part and then connects ta NS series T,
Scans the Port Setting automatically until finding NS series PT.

If executing this procedure then CPU RS-232C Port setting is overwritten,
Ensute that it is not connecting with this port then execute it.

Present setting: MT Link, Standard

Are you sure?

Click [OK] @
< =

(4) Check the CPU DIP switch.
¢ Follow the on screen instructions to change the DIP switch.

CX-Integrator | x|
@ Skart communicating with MT series PT ko analize the setting automatically.

Ensure that Dip Switch 5 of CPU unit is OFF,
It is the setting to change from RS5-232C Port to NT Link,

Click [OK]  *=*===srsssssssasauss

(5) Screen message Connecting . . . is now cleared.

(6) Next, upload the network configuration information of NT Link.

Select LR .
[Transfer [Network to PC]] *====qF==""" Node(1). Unit0]
1], Mode(1]. Unit1]

Connect ). Model-J, Unit(3]

Stark Data Link

Skart Routing Table

MT Link Taoal »

Controller Link Tool 4

4| |
CX-Integrator E

Metwork structurefMetwork Mo, : Mone) will be tranferred.
Flease transfer the network parameter For each component if needed because they are not transfered here (in the
case of Controller Link and SYSMAC LIMK).

Do vou wish ta continue?

Cl|ck[Yes] SN EEEEEEE NN NN EEEEEEEEEEEE

(7) After the transfer is confirmed, connected devices on the current NT Link network are
displayed as shown below.

= Network1_CPU Port_Serial Port(NTLink}{-} H=
Netwark1_CPU Part_Serial Port[NTLink] o
Compol Compo2
ﬂl il 7
== -
NSE-TYO0-
CJAM-CPUTE i
[ 'l H|
|
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Controller Link Start-Up I

Remove Controller Link communications errors and establish communications.
= ON state of Controller Link Master Unit's INS LED
= Check Controller Link configuration through CX-Integrator.

(1) Connect to PLC online, then connect to Controller Link Unit through the online connection
information window.

_| =- Q, Online Toolbus COMT.9600 Mone. 8.1 [CITR-CPUT 3] Met(0]. Mode(0)

SRl T et PLC [C110-CPLUTE] Metid), Node(0]
----- -jg CPU PartSerial Park:MTLink [CITH-CPUT3] Net(-), Model-). Unit[252)
----- -él-"f- DeviceMet [CI1W-DRM21] Met[2], Mode(1], Unit(0]
----- 'ij Contraller Link JC1 1 -CLEZT ] Metd ] fade(1] Lnit[1]

..... =i SCUPart [T Transfer[Metwork o PC]

Right-click a Controller
Link Unit in the online
connection information
window, then select
[Connect]

Cannect

=

(2) Next, upload the Controller Link network configuration information.

Skavk Mok linle

_I El- g Online Toolbus COMIT,9600,Maone,8,1 [CITh-CPUT 3] MNet(0), Mode(0]
E@ T;qur FLLC [| J1mM-CPLIT3 ]”n—-lllll ”lujn-||||
gy CPU Port [CI-CPUT3] Het(), Nodef-), Uritf-)
—j‘fj DeviceMet [CJ1hw- DHM21]Net[2] Nu:ude[1] LInlt[EI]
Select j% Contraller Link, [2) [ [ [1]
[Transfer [Network to PC]] === =adrassnnssnagde st ppat (o MG IS

Conneck

Skzvk Mizkz il

=

Transfer[Metwork[#001] to PC]

Flease select the transferred data, and press [Transfer] buttan.

© Mebwork stiucture anly

 Mebwork stucture and Parameters for each component

Pleaze transfer the netwark parameter far each component if
needed because they are not transfered here [in the case of
Cantraller Link and SYSMAC LINE].

Click ['rransfer] EE NS EEEEE NN NN NN EEEEEEEEEEE

Tranzfer Cancel

=



PLC Network PLC
Start-Up Start-Up

Select

[Transfer [Network to PC]] '®==""j=====""
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Saving
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DeviceNet NT Link
Start-Up Start-Up

CompoWay

/F Start-Up 4 System

Config.

(3) After the transfer is confirmed, connected devices on the current Controller Link network are

displayed as shown below.

:n NetworkZ({ControllerLink){#001) !E

Metvrork2[Contraller Link] [HOO01] -

Compa3 Compaod

CJIM-CPUTG CHG-CRU4SH
HOO1 HOO2

| I 4

Ad|

In this example, although three PLCs are actually connected through the Controller Link,
in this start-up example explanation assume that only two PLCs are displayed.
(One PLC did not join the communications due to incorrect Routing Table settings)

=

(4) Check the Routing Table and configure it correctly.
See “Confirming the Routing Table is not Configured” for configuration details.

(5) Re-upload the Controller Link network configuration information.

_| =™ Orling Toolbus COM1,3600 Hone 8.1 [CITM-CPU13] Met0), Mode(0)
SR Toget PLE [CI1M-CPLUTE] Net], Mode(0]

----- =i CPLU Port [CHM-CPUT3] Met-), Model-, Urit]-]

----- -j'f- Dew:eNet [EJ'IW DHM21]Net[2] Nu:ude[1] Llnlt[EI]

Ckaek Mizka il

=

Tranzfer[Network[#001] to PC] | % |

Flease select the transfered data, and press [Transfer] button.

€ Netwaork structure only

% Network structure and Parameters for each component

Please transfer the netwark. parameter for each component if
needed becauze they are not transfered here [in the caze of
Caontroller Link and SvSHALC LINE].

Click[TranSfer] NSNS ESEEEEEEEEEEEEEEEEEEEE I Cancel

(6) Send the network configuration from the network to the personal computer.

. Network2{ControllerLink){#001) H=]
Netwark2[Contraller Link] [H007] -
Compo3d Compod Compod
CJIM-CPU1S CH1G-CPU4SH CJ1G-CPU45H
HOO1 HOO2 HOO3
N 1 T
A

Controller

Diagnosis



PLC Network
Start-Up

PLC
Start-Up

Right-click an SCU port in
the online connection
information window, then
select [Connect]

(il

Select SCU port (140)

(il

Select CompoWay/F

Right-click an SCU port in
the online connection
information window, then
select [Transfer [Network

to PC]]
=
=

Click [Yes] in the message
dialog box

Select [Selection], enter
1 for minimum and 2 for

maximum values, then
click the [OK] button

Controller
Link
Start-Up

NT Link
Start-Up

DeviceNet
Start-Up

CompoWay
/F Start-Up

CompoWay/F Start-Up I

Controller
Link
Diagnosis

System
Config.
Verification

Saving

System
Config.

Remove CompoWay/F communications errors and establish communications.

= Check CompoWay/F configuration through CX-Integrator.
= Configure serial communications Unit parameters.
= Configure temperature controller communications.

This example explains the start-up of a serial communications Unit with two temperature

controllers (E5SCN) connected via CompoWay/F.

* Two temperature controllers (E5SCN) are connected to serial communications Unit
(CS1W-SCU41-V1) port no. 1 via RS485. Communication Unit numbers are #001 and #002.
e Communication settings of the serial communications Unit and the two temperature controllers are

unmatched.

o Communication settings between the two temperature controllers are unmatched as well.

(1) Connectto PLC online, then connect to a CPU Unit through the online connection

information window.

_| -3 Qrline Toolbus EDM1 SEDD MNone 8,1 [CITM- EPU13]Net[D] Made(0)

El@

Cx-Integrator

Selected ltem  SCIU Port(140) : PORT

Select the item from the following list

' oK i . Cancel |

*
¥
*
*

Click

CX-Integrator

Selected tem  Compo'w apF

Select the item from the following list.

' Cancel
="

(2) Upload the CompoWay/F network configuration information.

x =- Q, Onling Toolbus EDM‘I 9600 Mane, 8.1 [CITH- EF'U13] Met{0). Hode(0)

—}; EF‘U Port [CJ1M EPU13]Net[] Node[] Unit(-)

'LIL' DeviceMet [CI1w-DRM21] Met[2], Node(1], Unit{0]
-.f.— Eontroller Llnk [CJ‘IW' ELK21]Net[‘I] Mode(1]. Unit(1)
; U i

Trans| h—-r[l’]

Conneck

=

Network structurefhetwork Mo, : Mone) will be tranferred.

C%-Integrator
& case of Controller Link and SYSMAC LINK).

Do you wish to continue?

11471451 Met(-], Mode(-). Urit(140]

Please transfer the network parameter for each component if needed because they are not transfered here (in the

Compoway/F Finding node se... B3

Select finding node range.

& all0-a9)

[ " Selection

Iin |1_ ax |21_

It will take bwo seconds or less per
i

Click

° aK Cancel |

Click B




PLC Network PLC
Start-Up Start-Up

Click [OK]

Then click the [OK] button

in the d|a|og box indicating :-----------------------------------

completion of transmission

CPU in the [Network
Structure] window and
double-click

=

From the menu, select
[Component | Mode Setting]
to display the [PLC Mode
Setting] dialog box

ma,
--.....
L
"

Controller Saving System Controller

DeviceNet NT Link CompoWay

N N Link g System Config. Link
Sl Sl Start-Up e Config. Verification Diagnosis
CX-Integrator

This dialog box is displayed because communication is
& . not established between the serial communications
Cannot aquire the Slave node, )
Unit and temperature controllers.

l....

CX-Integrator E

@ The parameters were transferred

(3) Adjust the serial communications board parameters settings to those of the CompoWay/F.

Place the cursor on CJ1M- . - NetworkZ_Unit(3)_PORT1(CompoWayF){-} _[O[x
'.... Metwork2_Unit[3]_PORT1[CompoWayF] = The [Network Structure] W|ndOW
Y
°”"‘f’°“ L shows a CPU Unit (CJ1IM-CPU13)
i that has a serial communications
EREEUE Unit, but neither of the two
= temperature controllers.
|
|
ode Address: 0 CHM-CPLN3
1)
@ Frogrami " Aun ( s | (2)

(1) Select [Program] for
operation mode

(2) Click [Set]

(3) Click [Close] after

changing
gl

From the [Display
Parameter] pull-down menu,
select [Portl: Serial
Gateway Settings]

=

Click [OK] in the [Edit
Parameters] dialog box and
close the dialog box

Perform the step (2) in the
previous page

Click [OK] button in a dialog
box indicating completion of
transmission

-_,--“ € Monitor € Debug
-

=] Configure [Portl: Port settings] to [Manual]
Orilne Status: and [Portl: Serial communications mode] to

[Mads Command has been completed . .
3) [Serial Gateway]. _Check other settings as
(W) well, and change if necessary.

LI1W-5LU41-¥1 [Ldit Pararveters]

LI1W-50UH1-¥1 [ dit Parareters]
»

. o
Dlmlavedl"uame-rh-':-'.'l Sensl Gaveray Settngs =] Displaye swameten | Pose1: Sesinl Gatewiay Settings =]
an®®® *  —— n
PPTL i Tem I Betvalm | unit | ' B T 1 11—
Pon: Pon setlings |Vser semings | Pant o sadings Uit stingss
Foml: Senal communicstions mode | Serlal Gateway Portl: Senal communicalions mode | Sensl Galeway
Part. Dia lienglh 7 bits Forl: Data length [7oms
Fan1 . Stop bils [2ms Por: Stop bits [2bis
Par: Pandy |Even | Fartl: Pany [Even
Pont: Baud rate Defaultga00b0s) Port, Baud rale Delaull{I500b0s)
Portl: Send delay Deefault (0 ms) Parll: Send dilay Drefisult {0 rroes)
Pari1: Sund dufiy (user-specified) |0 |ms Pam: Sond dolay (user-spocled) |01 [ms
Par: CTE contral [0 | Pam: CTE control 82, |
Portl: Response imaout mononngti |0 ms WSETEERNEE .
Click the reset button to
enable settings. Click [OK]
in the reset confirmation
Hel Hel i
o[ N - message dialog box.
chdeheen WourkD 3030, Bie 811 hddesWoitD130300, D11
aTypesList «TypeList
- ~ = o
ToansledUnt toPC] | TrantedPC tolinkt] | Compwe | Fleset TransieilPC o Uri] ( Beset '
Set Dl [ o ]| coed Set Datolts 0K | Gecdl

Confirm that settings are correct, then select the
[Transfer [PC to Unit]] button. Click [OK] in the
transmission confirmation message dialog box.

Select Port B Edit Parameters [}

Select & port ta rezet from the list below
The unit was reset

Select i —
.s® H

[HOSTLINK1]
and click [OK] e,
button. .

.. -
R () clck

(4) Re-upload the network configuration information of CompoWay/F. Perform the step (2)

from the previous page. @

Only the Units for which connection is established are displayed in the [Network Structure]
window, as shown on the next page.




PLC Network
Start-Up

PLC
Start-Up

Check the temperature
controller that is not
displayed properly and
configure it correctly

Perform step (2) from two
pages ago

=
]

Right-click on the
communications Unit
number #002 icon in the
[Network Structure] window,
then select [Start Special
Application] > [Start with
Setting Inherited)]

After parameter settings
are finished, select
[Communications] >
[Download to Device], then
select either [Download all],
[Download Changed
Parameters], or [Download
Changed from Default]

g,

DeviceNet
Start-Up

Controller
Link
Start-Up

NT Link

Start-Up /F Start-Up

= Network1_Unit(3)_PORT1{CompoWayF){-)
Metwork1_Unit[3]_PORT1[Compo’ia

Compo

CJIr-CPUAS

CompoWay

Controller
Link
Diagnosis

System
Config.
Verification

=] E3
> The [Network Structure] window
shows only the Units for which
L=== connection is established, and Units
with incorrect communications
setting are not displayed.
=

(5) Check the settings of the temperature

controller that is not displayed in the [Network

Structure] window (baud rate, data length, stop bit, parity, Unit number), configure it correctly,
then re-upload (Perform step (2) from two pages ago). The [Network Structure] window is

updated.
- Network1_Unit(3)_PORT1{CompoWayF){-)
Metwork1_Unit (3]_PORT1(Compo'iiayF]

Compo2 Compa3

Compo

CJIr-CPUAS

Now the correctly configured Unit is
displayed and you can confirm that
communications settings are correct.

(6) Move the cursor on E5CN of communications Unit number #002, then select [Start Special
Application] > [Start with Setting Inherited].

- Network1_Unit(3)_PORT1{CompoWayF)(-}

Network1_LUrit [(3)_PORTA [CompoiayF]
[m]

Compo2
Compal SR

ﬁ.,.—l s = s

ESCH

o
o

Parametet

CJIM-CPUAS #001

Copy

ﬂ Paste

Togdle Paosition

Delete

Chrl+C
Chrl

Edit: Mame. ..
Edit Mode Address

ecial Application

SEEFE Oty

(6) Dedicated Support Software CX-Thermo is started with the same model and setting as

that of the temperature controller.

After parameter settings are finished, download the settings to the ES5CN of
communications Unit number #002.
- Thermn [_[]=]
Fiolf) Commuications(T) Wiew(Y) TrendMonder(l) Option(Q) HelplH)
IR IV LW
o o I{} e Charend -1
CHY  Channel - 1
Pasamoles Mamn Sl Pord
Setting Range 200 - 1300
D oo Paomsa o (| ve Usdsell)
=3 Opesation level
] Set Poirt
TR oo UL Vi T
!ﬂhml:mlntudrl
!Nnmud-? |
B P
) Al Ve 3
%mfﬁt:::; e the recued terpesshaelS e o]
= Attt bevel
W SPO
B o =l
[DL2105 12 44:31) [e5cn] w bvanched ficas X [ntegraton o the On koe etate. ;I
L2105 12:44:41) The setting of e 5en BT baging
[Cunfizmany Le cunnectan
. "Thrvice bering eckited 20w is HOT corespoading to “corawcted Devioy™ _I
(010720005 1:2.84:50) The setting of o 5en-COATIT.FLE bagira
Uit nosbarfIZ) O bine b-|
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DeviceNet NT Link Controller

System Controller

: CompoWay : ;
" ) N N Link g Config. Link
Start-Up Start-Up Start-Up Start-Up Start-Up /F Start-Up Verification Diagnosis
Saving System Configuration (1) I
Save the system configuration for inspection after delivery.
(1) Connect online to a PLC on a network.
The online connection information window is displayed.
_| = ,@, Online Toolbus COM1,9600,Mone, 8,1 [C11M-CPU13] Net(0), Node(d) A” Communications UnitS and pOI’tS Of
KT i .
1 Node[ ], Uritf] ===x @ connected PLC are automatically
o5 DeviceMet [CITW-DRM21] Met(2], Made[1), Unit[0) 3 A A A
-j‘g Contraller Link [CJ 1w/ -CLE21] Met(1), Made(1], Unit(1] _dlsplaye_d n the Onllne Conne_Ctlo_n
egly SCU Pot [CITw-SCLI41 1] Nett), Hods(, Lini(3) information window. From this window,
connect to each network and save the
- configuration to a project file.
(2) Send the network Structure of DeviceNet to the personal computer.
Connect to DeviceNet from the online connection information window. After connection
Move the cursor on the is established, send the network Structure of DeviceNet to the personal computer.
DeviceNet and right-click
_TII = % %\me Tnlhus COk1,9600.| Nnnem [E.J1MEF'LI13]Nat[D] Mode(0] j = Q Online Too\us EEIMT SSU Nones‘\ [CJTH- EPU13]Net[U] Mode(0]

Select [Connect]

e s Controller Link [CIW-CLE21] Net[1], Noe  TransterlHetwork toPC]
L] - - -

SIS ok (630 SCU 4T/ N g Hode

Select

Start: Diata link

[Transfer[NetworktoPC]]""""""""""""""""""""""""""""""""""""" -

o*
.
Shark DAnikinn Tahla

Select the connection menu on the CPU port, then select upper link port and NT Link.
Next, select the transmission menu on the CPU port.

ne 8.1 [CJ1M-CPUA 3] Met(0), Node(0)

[ ] (3) Send the network configuration of NT Link to the personal computer.

x| Eg Online Toolbus COM1,9600.Maone,8.1 [CI1M-CPUT3] Met0), Node(0]

5]
-j‘g DeviceMet [C1TwW-DRM21] Net[2). NDdE[ TransFer[Nethrk ko BC] DeviceNet [CJTw-DRM21] Net(2). Mode[
-t Controller Link [CJ1wW-CLK21] Met(1]. Moc Cartroller Link [CH%-CLK21] Nat(1), Mo
Select [CONNECt] ===msmsseysnens SFapsrney i minmedas 2 SCU Port [CITW ST Y1 Netf], Nore , e ST5EE
T SEtDats ok 13 Start Data Link.
. D
SeIeCt Start Routing Table o .* Start Routing Table
[Transfer[NetworktoPC]]--------------------------------W---- sssEsEEEEEEEEEEEEEEEY —
é )
Select
q a Selected ltem  CPU Port[252) : Senal Port Selected ltem  MTLink
[Serial Port] > [NT Link] B s s snusannnunsnnnnunnny
Select the item from the: following list Select the item from the: following list.
LD e Compgh/ ayF
EF'U F'Url[253] Fenpheral Port
b Cancel | Cancel
E ] \ J

(4) Send the Controller Link network configuration to the personal computer.
Connect to the Controller Link network. After connection is established, send the network
configuration to the personal computer.

2| =™ Orline Toolbus CDM1 9E00.Nane ET [CJ1M-CPUT3] Met0], Node(0)
JET [N cee] | i)

Ol (M 2|
SCU Pt [E.HW SCL4T V1]Nat[] Mot

Transker[Hetwork bo PE]

Select [Connect] sssssuss
Select
[Transfer [Networkto PC]]---------------------------------------.-------------------------------“
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/F Start-Up

Saving System Configuration (2) I

(5) Connect to a PLC on the Controller Link network.

Select a remote PLC on the Controller Link network configuration screen (a PLC without a
square symbol) to switch the connection destination to the PLC.

Destination PLC communication device configuration is displayed in the online connection
information window.

- Network3(ControllerLink){#001) H[=] B3

Hetworle3 (CantrollerLink] #001]

A Green frame is displayed on

=] a =]
Compo3 Compod CompaS | e
the specified remote PLC.
e = Parameter
o u
Displary E L I i
CHM-CPUTE CHECPL isplay Error Log ; = = Network3({ControllerLink)(#001)
4001 Status{Error of Communication Uit Network3[Controlier Link) (0 =

Etror Log of Communication Unit

Compo3 Compod CompoS J

CHM-CPUTZ C1G-CPU4SH CJ1G-CPU4SH
HO01 HOD2 #003

Select [Change
connection to this PLC]

=

= =- @. Orline Toolbus COM1 3600 M one, 81 [CI14 EPLI13] Net(0). Node(0]

All communications Units and
ports are also displayed in the
online connection information

Iz

o CPU Port [CHG-CPLU4SH] Met(-], Made(-), Unit(-)
o DeviceMet [ClTwW-DRM21] Met(2), Node(S), Unit0)

L ﬂ Contraller Link [C)1w-CLE21] Met(1], Mode(2), Unit{1)

window.

(6) Send the DeviceNet network configuration on the remote PLC.

Connect to DeviceNet from the online connection information window and send the

network configuration to the personal computer.

00, None, 8.1 [C1h- CF’U13] Net(0), Node(0] ill = g gE\In’ve Toolbus COMT,9600,Mone, 8,1 [CJTM-CPUT3] Net(0), Node(0]
=} e 2)

_I =] @, Orline: Toolbus CDM

12 [
f@ Comtroller Llnk [CJ]W CLEZ TransFar[NetworK to P

Select [CONNECt] sssssssspesssssssssnannnnnnn

QungtP

** et Data Link
*

Sttt Data Lk

Select o
[Transfer [Network to PC]] =sssssssssssasssssssnsnsnsssnsnanannnnsnnnnnnnannnnnnannnnnnnnnannnnns®

(7) Send the DeviceNet network configuration on another remote PLC.

Repeat the steps from (6) and (7). After transmission, all the networks sent to the
workspace are displayed.

2] =

E--% WNewPraject

ﬁ Metwork 1 [DeviceM et)[HO02)
Metwork2_CPU Part_Serial Port{M T Link|[-)
 Metwork 3[ControllerLink)(#007]
o Metwork 4[DeviceM et)[HO03)
oty MetwarkS(Devicah st HO04)

~ Project ]

(8) Save all the configurations.

- CX-Integrator - [Network1

ewProject

Jf“s’ﬁ Edit Yiew Insert Metwork Compone
H C D Hew Chrl+ E | = |

Qp N Chrl+0
Cl

o -

;ngave Chrl+S —
Select [Save As...] smsssssssEsssmEmEnn s n e

0Z2)
Impart. .. b Jal Port{NTL
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Confirm that the System has the same wiring and settings as before disassembly.
= CX-Integrator verification is complete.
(1) Connect online to a PLC on a network.
The online connection information window is displayed.
1 [CI1M-CPUT3] Het(a], Mods{0) All communications Units and ports
CPU Part [mM—EPLHS] Nr] Nnde[], Uri-) I ofa conpected _PLC are. .
E Devieshet [CTW-DAM21] Net(2), Nods{1), Uri0) automatically displayed in the online
gy Contraller Link [CI1W-CLK21] Net1), Nadef1], Unit{1) a c 7 q
connection information window.

=

(2) Verify the DeviceNet network configuration.
Connect to a target DeviceNet from the workspace and verify the network Structure.

) )
= % MNewProject
7} -;i;-— Metworl
%) MNetwork o Metworl  Insert [ebwork
% Metworl
Metwork e Networl Delete
Transfer[PiC ta Metwork]
Transfer[Metwork ko PC]
Select [Connect] ===ssssssssssasaaanannns Ji
. 2
.
Rename [Netwath . ** Rename Mebwork
(Zhange Mebwork Address . “‘ Change MNetwork Address
Se|ect[Compare] LR L CECEE RS EN Y XL, sssssssssnnmnnnnnnng® p—
Project I Paste(Ey Project I Paste(F)

- ;

(3) Any error found in the configuration verification will be displayed in the verification result

dialog box.
Compatison Result
e freees JESTE ™\ ....... lfyoufind a Slave that is not on
10 Device Tupe of #05 s different. CITw-DRM21 It doesn't exist, )

the network, you may have
incorrect wiring in the network.

Click [Close]
L >

(4) After solving the error, verify the configuration again.

A message is displayed indicating
@ Hio dfferences were found. verification matching and now it can
Click [OK] - . be confirmed that the configuration is

the same as that before disassembly.
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System Configuration Verification (2) I

(5) Verify the NT Link network

Connect to the NT Link from the workspace and verify the network configuration.
Confirm that the same verification matching message is displayed as in step (4).

E--% MewProject

Metwark
Metwark

Select [Connect]

Rename Network
SN EEEE NN NN NN EEEEEEENEEE

Select [Compare]

(6) Verify the Controller Link network.
Connect to DeviceNet from the online connection information window and verify the

network Structure.

] x|
E\% MewPraject
gy Metwork 1 [DeviceMet[#002)
o3} Network 2 DLl Port Seria] Por,
T Network  Open
Metwork  Insert Metwork
“edy Network
== Delete
Transfer[PC ta Metwork]
Transfer[Metwork to PC]
o - 000000
.
Ry . Rename fetwark
pumEs D T N T

Confirm that the same verification matching message is displayed as in step (4).

=l =l

- % MNewProject
- -55 Metwark1[DeviceNet)[#002]

'éf':' MNetwork  Insert MetRork

TransferPE bl etwark]
Transter[Met Pz]
Cofpare
Connect

Select [Connect]

Rename Metwork.
.
INEEEEE NN EEE NN EEEENEEEEEEEEEEEEEEEEEEEEEEEEEEEmmmus®

Select [Compare]

2l x|
E--% MewPraject
g Network [Deviceh st #002)
’;5 MNetwork2_CPU Port_Serial Port[NT Link)[-]
g Network  Gpen
g Network  Insert Hetviork
Delete
Transfer[PC ta Metwork]
Transfer[Netwark to PC]
> 3
(%4 |
- Renarne Metwork

(7) Connect to a PLC on the Controller Link network.
Connect to a remote PLC using the same procedure as the step (5) for saving a System

configuration.

Use steps from (2) to (4) to verify the DeviceNet network.

o Network3(ControllerLink){#001)

Hetwark3(ContallerLink)HO0)

= ES

CompaS |

Compa3 Compod
ﬁ ﬁ Parameter
o
Display Errar Log
CJ1M-CPU1Z CHG-CPL
Ha01 o = Status/Errar of Communication Unit
l WF Error Log of Communication Uinit
[

Select [Change
connection to this PLC]

E% MNewProject
afr Metwork1[DevicaNet)#002)

Select [Connect]

"y
Ty
-.....
"y
o

Select [Compare]

== Network3({ControllerLink){(#001)

Network3(CorerallerLink)

Compe3 Compos CompeS J
CHM-CPU CHG-CPU4SH CHG-CPL4SH
#001 a2 HOO3

]

=

E-E_, Online Toolbus COM1,9600,MNone,B,1 [CJ1M-CPUT 3] Net[0], Node(0]
tzue] T et PLC [C)1G-CPU45H) Ne

Ll
o

= CPU Port [CJ1G-CPU4EH] Met
-5-‘5 DeviceMet [CI1W-DRM21] Net(2), Mode[5). Unit0)
~zig) Contraller Link [CJ14-CLK21] Met(1), Node(2), Unit1]

. Nodel-), Urit(-]

(8) Verify the DeviceNet configuration on another remote PLC.
Use the same procedure as step (2) for Network “N4” to verify the network Structure.
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Start-Up Start-Up

Controller
Link
Diagnosis

DeviceNet NT Link Controller

Start-Up Start-Up St:liir?-lth

System
Config.
Verification

CompoWay
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Controller Link Diagnosis I

Confirm that the Controller Link connection is correct with an upper level System.
= Diagnosis result check OK

(1) Connectto PLC online, then connect to Controller Link Unit through the online connection
information window.

2| =™ Online Toolbus COMT.9600 Mone, 8.1 [CITM-CPUT 3] Net(0). Hods(0]
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Unit under Target Device **=* =5t =====s=sarasasassd
in the online connection Start Data Link
information window, then Start Rauting Table
select [Connect]

MT Link Tool 3
Contraller Link Toal r
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(2) Next, select the Controller Link network tool.
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Start Data Link
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MT Link Tool 3
Controller Link Tool

Mek Diagnosis

& Controller Link Network Diagnostic Tool - [NodeConfigTemp.crg]
File(E) Wisw(\¥) PLC(R) Diagnose(D) Node Status(M) Help(H)
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Transmission Fath: Wire Type Data Link: _

Baud Rate:  2Mbps Comm. Cycle Time 4.8ms Polling Mode Node2 Starting Mode:

Results Lewvel | Mode | Diagnostic Message |
(&) Information Contraller Link Network is correct

Ready

[Networkt Model




Servo/inverter
Settings

Right-click on 3G3MV-
PDRT2 and select [Start
Special Application]

(

Select [Start with Setting
Inherited]

Ud

CX-Drive starts and
Inverter property
settings are shown

Save data

DeviceNet

Connection

RS232C
Connection

Starting CX-Drive via DeviceNet

Setup Drives on DeviceNet and start CX-Drive on
An example of 3G3MV-PDRT2 is shown below.

When opening a stored data file after starting

CX-Integrator window.

the dedicated tool, select [Start

Only]. If [Start with Setting Inherited] is selected, new data is created.

=5,NewProject - CX-Integrator

Fle Edit View Insert Network Component Tools Windows Help
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& Project I
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S Communications Adapte! ™ ¥ & uf

ChrlHC
Ehrly.
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=55 Network (D

CPS  EDS[Devicelet]

Change Node address:
" mge Device Comment. ..
gt

x| = = Oniine 8.1 [CI1G-CPUA2H] Net(0), Node(0)

el 1oL : e
. Unit[-]

(1], Mode(8), Unit[1)
DeviceMet [CITW-DRM21] Met(12). Model832), Unit(5]
= Ethernet [CITW-ETH11] Met(10). Mode(104). Urit(10]

AT Resut / | BRI
|Launch related Special Application [@ onrline
Xl
—Drive Mame
|Dr iverl
—Drive Type ——
IIrwerter j ISGSMV W7 - Settings.. b .

3GIMY-A2004-PRGIZ VT
+3GIMV-FDRT2

""**=..., Select Settings to set
detailed Inverter specifications.

—Connection Type

Settings..
—Comments
Tvpe wour own comment in here, ;l
[ -]
OF I Cancel | Help I

Click [& I and save the data.

If more than one drive setting data is edited, drive data is saved by drive type and a total

overview is saved in a work file.



Servo/inverter DeviceNet RS232C
Settings Connection Connection

Connecting a Servo or Inverter to a Personal Computer Serially.

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Drive] > [CX-Drive] to
start CX-Drive when you connect Servo or Inverter with serial connection to your computer.

Select [File] > [New] to create new data if the drive specifications are known.
If the drive is already connected, select [File] > [Autodetect] to detect the model
and specification of this connected drive.

New Drive x|
| ~Drive Name
|Drive1
. —Drive Tvpe
Select [Settings] ==
[ gs] ®sa., L [frwerter | [paam osm =l Settings..
. ——— — 1
----..... 2GAMYV-A2004-PRG32 0T
llll.....
LY

@ —Connection Type alL I

I Direct

Settings..

—Comments

e c_o_mm_unication Tvpe your own commernt in twork . =
Specifications | river |

Slave Unit Address
QK I

Communications Timeout 1000

Make default

~ e

@ MHumber of retries

[ ok | cancel | Help

=

Or, select [File] > [Autodetect] to detect the connected drive specification.

To execute
Autodetect, select
[Settings] and define _

the search conditions [ [ Drive |Proper| Connection Description " "

]
—J <l | 2l
e

Save data Click E I and save the data.
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1. Personal Computer Requirements

Item System Requirements*
Operating System (OS) Microsoft® Microsoft® Microsoft® Microsoft®
(Note 1) Windows® 98SE Windows® NT Windows® 2000 Windows® XP
Japanese or English version (Service Pack 6a) (Service Pack 3 or
higher)/
Windows® Me
Main Unit DOS/V (IBM AT compatible) computer with a Pentium 1l 333 MHz processor or higher.
Pentium Il 1GHz or higher is recommended.
Memory 256MB or higher required (Note 2)
Hard drive To install entire CX-One, about 1.8GB or more free space is required.
Display High quality display with SVGA (800 x 600) or higher and 256 colors or more.
Optical drive CD-ROM drive
Communication port At least 1 RS-232C port (Note 3)
Others For online user registration via the Internet, you need appropriate hardware such as
modem and Internet access rights.

(Note 1):

About operating System for CX-One:

This product does not run on Microsoft Windows95 or other OS versions other than the specified
System requirements.

If you have such an Operating System on a client computer, you must upgrade the Operating
System before installing this product.

Note that the required System and hard drive capacity depend on the System environment.

(Note 2):
The required memory depends on the CX-One Support Software. See the User’'s manual for details.

(Note 3):
An RS-232C port is required for connection with a PLC using CX-One Support Software. If you only
have USB on your personal computer, use a USB-RS-232C conversion cable (CS1W-CIF31).




2. List of Software to be Installed

CX-One Support Software installed with CX-One is shown below.

CX-One Support | Description Required free | Remarks
Software space on
hard drive
CX-Programmer | Software to create and debug programs for SYSMAC CS/CJ series, ca. 250MB | If necessary
C series, or CVM1/C series.
CX-Integrator Software to start up and configure FA networks such as Controller ca. 100MB
Link, DeviceNet, and CompoWay/F.
CX-Position Software to create and monitor various data for SYSMAC CS/CJ ca. 15MB
series NC Unit.
CX-Motion Software to create various data for MC Unit of SYSMAC CS/CJ ca. 40MB
series, alpha series, and CV series and to create and monitor MC
programs.
CX-Motion-NCF | Software to create and monitor various data for SYSMAC CS/CJ ca. 100MB
series NCF Unit.
CX-Motion-MCH | Software to create various data, motion programs and monitor the ca. 100MB
SYSMAC CS/CJ series MCH Unit.
CX-Drive Software to configure and adjust various inverter servo data. ca. 100MB
CX-Designer Software to create screen data for programmable terminal NS series.| ca. 500MB
CX-Process Software to create and debug instrument block programs for loop ca. 65MB
Tool control Unit board, process, and loop CPU Unit of SYSMAC CS/CJ
series.
Face P|E_1te Software to automatically generate NS series project files for ca. 50MB
Auto-Builder monitoring and tuning of a loop controller.
for NS
CX-Protocol Software to create data transmission procedure (protocol) with an ca. 20MB
external universal device that is connected to a serial
communications board/Unit of SYSMAC CS/CJ series and SYSMAC
alpha series.
CX-Profibus Software to configure the PROFIBUS Master. ca. 10MB
(Possible to install Windows NT4.0/2000/XP only.) '
CX-Simulator Software to debug programs for SYSMAC CS/CJ series without the ca. 40MB
CPU Unit by simulating the CPU operation on a personal computer.
CX-Thermo Software to configure and adjust parameters for devices ca. 20MB
(Components such as temperature controller).
(Possible to install Windows 2000/XP only.)
CX-FLnet Software to configure and monitor the SYSMAC CS/CJ series FLnet ca. 1MB
Unit.
Switch Box Utility software to support PLC debugging. Input/output status and ca. 5MB
Utility current values of address in a user-specified PLC can be monitored
and modified easily.
PLC Support A group of Components that are commonly used by software that ca. 300MB | Always
Software consists CX-One, such as CX-Programmer and CX-Integrator. installed
CX-Server Middleware required for communications between CX-One Support

Software and OMRON’s Components such as PLC, indicator, or
temperature controller.

About 1.8GB of free hard drive space is required on your personal computer to install all CX-One Support

Software.

Make sure that sufficient free space is available.




3. Comparison of Functions Between Conventional Support Software and

CX-One (1/2)

Function

Conventional Support Software

CX-One

Handling of CX-Programmer’s I/O Table
window

Only mounted Unit position information

® Shows used position/size only

(only head address and size of used area
in ClO area are displayed)

@ Assignment DM setting of CPU Bus
Units and Special I/0 Units is unavailable.

In addition to traditional functions, the
following functions are available:

@ Used as a setting terminal of CPU Bus
Units and Special I/O Units

® Used as a terminal to start each Unit's
Support Software

Initial setting of CPU Bus Units and
Special 1/0 Units (assignment DM,
assignment relay, CPU Bus Unit System
setting)

@ Configuring four-digit hexadecimal or
other value for each address by referring to
assignment DM area on the manual using
PLC memory as with universal DM area.
(Direct setting in many cases)

D | | |
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* |t is necessary to configure values while
checking addresses based on Unit number.

And the data are not saved as parameter
data for each Unit (only as DM data for a
CPU Unit).

@ By right-clicking a target Unit on the I/O
Table and selecting [Unit Setup],
configuration is available of CPU Bus Units
and Special I/0O Units parameter (mainly
allocation DM) setting without referring to a
manual in the following dialog box.
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* Setting is available using item names
without recognizing addresses. Also, data
can be saved/read as a parameter setting
data file for each Unit.

@ Setup data can be handled in the same
way as other I/0O memory areas for saving
into a CXP project file or as a data file of
file memory.

@ Setup data can be saved in a parameter
setting data file for each Unit, or into a CXP
project file for entire Units’ parameter settings.

Network | Ethernet | CPU Bus Unit By [Unit Setting] in the online CX- By right-clicking on an Ethernet Unit of the
setting System Setting for | Programmer’s I/O Table. 1/0 Table and selecting [Unit Setup]. Can be
Ethernet Unit saved as a parameter as with other CPU Bus
Units and Special I/O Units.
Ethernet network No tool for monitoring Ethernet network. Ethernet network connection device can be
monitor monitored by CX-Integrator.
Controller | Controller Link Unit | By right-clicking on a Controller Link Unit of | By right-clicking on an Controller Link Unit of
Link soft-switch setting | the I/O Table in the online CX-Programmer | the I/O Table online or offline and selecting

and selecting [Software Switch Setting].

[Unit Setup].

Controller Link Data
Link (manual or
automatic) setting

By CX-Net (Data Link Component) in CX-
Programmer.

Trough a Data Link Component by selecting
[Tools] > [Start Data Link] from CX-Integrator.

Controller Link
network monitor

No tool for monitoring Controller Link
network.

Controller Link network connection device
can be monitored by CX-Integrator.
Controller Link diagnosis tool can be started
as well (By selecting [Tools] > [Controller
Link Tool] > [Network Diagnosis] from online
CX-Integrator).




3. Comparison of Functions between Conventional Support Software and

CX-One (2/2)

Function Conventional Support Software CX-One
Network | DeviceNet Fixed assignment by | Fixed assignment: No setting tool Fixed assignment: By right-clicking on a
setting DeviceNet, or free (by edit on PLC memory). DeviceNet Unit of the I/0O Table online or
assignment by Free assignment: By DeviceNet offline and selecting [Unit Setup].
assignment DM. configurator. Free assignment: By right-clicking on a
DeviceNet Unit of the I/O Table through
online or offline CX-Integrator and selecting
[Edit Parameters].
Free assignment By DeviceNet configurator. By right-clicking on a DeviceNet Unit of the
and Slave parameter 1/0 Table and selecting [Start Special
setting/monitoring by Application] for device parameter edit.
DeviceNet
configurator
CompoWay/F | CompoWay/F Slave | By CX-Thermo Temperature controller: By right-clicking on
station parameter a target Unit through online or offline CX-
setting Integrator and selecting [Start Special
Application] to start CX-Thermo and edit the
setting.
Smart sensor: By right-clicking on a target
Unit through online or offline CX-Integrator
and selecting [Edit Parameters] to edit.
Routing Table By CX-Net (Routing Table By selecting [Tools] > [Start Routing Table]
Component) in CX-Programmer. from CX-Integrator to use Routing Table
Component.
(Note)

I/O Table can be started from CX-Programmer or CX-Integrator on CX-One.






